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Welcome to sPlan 8.0

 

Welcome to sPlan 8.0
 
sPlan enables you to create drawings (or other drawings) easily and conveniently with the
help of your computer. All components are simply dragged onto the drawing area and aligned.
With the help of the saved snap grid, precise work is guaranteed at all times.

All components and drawing elements are included as independent elements on your drawing.
You can group, move, rotate, copy, cut, paste, delete ...

In addition to the functions for drawing drawings, sPlan also provides you with other
interesting options such as automatic component numbering or integrated component list
management.

Much emphasis was also placed on the print version. In the convenient print preview you can
freely set the scaling, position the printout, etc. All changes are immediately visible in the
print preview.

The supplied component library can be expanded as required. You can set up completely new
libraries and thus adapt and expand your component library according to your wishes.

The software was designed in such a way that it can be operated as simply and intuitively as
possible. After a short training period, you will notice how easy it can be to create drawings
quickly and conveniently.

Further information and updates are available on our homepage: 

www.abacom-online.de
www.electronic-software-shop.com

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

New in version 8.0
 
For those switching from version 7.0, there is a list of all the main innovations in sPlan 8.0:

https://www.electronic-software-shop.com/index.php?language=en
https://www.electronic-software-shop.com/index.php?language=en
http://www.helpndoc.com
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New graphics engine
sPlan 8.0 now uses the modern Windows graphics engine (Direct2D). This results in a much
better and also a considerably faster graphic output. Now you can zoom and navigate
smoothly and smoothly even in more complex drawings, which makes working with sPlan much
more convenient.

High resolution monitor support (high DPI scaling)
sPlan 8.0 now directly supports scaling on high-resolution monitors. sPlan adopts the scaling
set in the Windows system and scales itself to it.

Properties panel
With the new properties panel on the right edge of the window, all properties of elements
can now be changed or viewed directly at any time. It is no longer necessary to call up a
dialog by double-clicking. Any changes to a property are also immediately visible on your
drawing. In this way you work even more effectively and intuitively.

New component library
The newly revised component library is now multi-level (with sub-categories). This allows the
library to be sorted in a much more structured and clear manner. The entire library can now
be backed up or a backup can be restored at the push of a button.

Unicode
sPlan now supports the full Unicode character set. This means that sPlan can display all
characters, such as Greek letters or special mathematical characters.

Numeric entry
Size specifications of individual elements such as circles or rectangles or position
specifications can now also be specified numerically directly in the properties if required.

New component lists
Component lists can now be defined more precisely. In addition, if desired, component lists
can be inserted directly into your page in a kind of table.

Table of Contents
If desired, a table of contents can be inserted directly into your drawing as a kind of table.

Angle snap when drawing lines
This function allows the lines to snap into place at 45 ° angles when drawing or editing. This
enables you to automatically and intuitively create precisely aligned connections, even
outside the set snap grid.

Bitmap functions
The resolution (dpi) of inserted bitmaps can now also be adjusted (reduced) directly in sPlan.
A reasonable reduction can save a lot of storage space. There is also a bitmap explorer with
which you can list all the bitmaps inserted in a project. This enables you to track down
unnecessary "memory hogs".

Text links / page references
There are now some new variables for automated designations available for creating text
links or page references.

Conversions line <> polygon
Each line can now be converted into a polygon and each polygon can be converted into a
line. That sounds unspectacular at first, but it is a very valuable aid for a lot of drawing
work.

Hatching
sPlan 8.0 now uses its own hatching technique to fill elements. Hatching can now also be
precisely defined with line width and line spacing. This new technique also eliminates any
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problems with hatching when printing.

Freehand lines
A new drawing mode allows you to easily draw freehand lines.

Page list
A new optional vertical page list makes it easier to navigate through the pages, especially for
very large projects with more than 20 pages.

Hotkeys for the drawing modes
With the (editable) hotkeys for the individual drawing modes, you can switch between the
modes even faster if necessary.

Full screen mode
With the full screen mode you can display your drawing in full format without any window
frames or other elements on the entire monitor. This can be particularly useful for
presentations.

... and many other functions and improvements

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Main window
 
The main windows of sPlan consists of different areas: 
 

 
The toolbar is located below the main menu. Here you can call up many of the program's
functions with a single click. If you hover the mouse over a button for a while, a short text

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com/help-authoring-tool
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for the toolbar button appears at the mouse position.

The component library with a light blue background is located on the left edge of the
window. Here you can select the individual library pages and drag the components onto the
drawing. You can determine the width of the component library with the mouse. To do this,
move the mouse to the right border of the library. The mouse pointer will now turn into a
double arrow. You can now determine the width of the library by holding down the mouse
button. Directly below the library you will find some buttons with which you can influence the
display of the library. Here you can, for example, set the number of columns or hide the
component names.

The mode toolbar for the individual drawing modes is located next to the component library.

To the right of it is the light yellow drawing area. Use this to create your drawing.

The properties panel is located to the right of the drawing area. Here you can change the
properties of individual elements or the page directly.

The tab-list for the pages is located under the drawing area. Here are the "tabs" for the
individual pages of the drawing. A click on the corresponding tab is sufficient to display the
respective page.

The status bar is located at the bottom of the window. Information such as coordinates is
displayed here. You also make basic settings here, such as the grid size or the snap mode.

Created with the Standard Edition of HelpNDoc: Easily create iPhone documentation

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Drawing of circuit diagrams

Created with the Standard Edition of HelpNDoc: Easily create CHM Help documents

Page settings
 
At the beginning of the work it makes sense to determine the format of the drawing.
The properties of a page are displayed in the properties panel on the right edge of the
window if no other element is currently selected on the plan: 
 

 
Here you can set the page size and the page format.

The name names your page. This name also appears as text in the page tab-list below.

You can also enter a more detailed description under Description. This extended description
appears as a tooltip on the page tab-list when the mouse is over it.

With the Reserved page option you can define pages as placeholders. Sometimes it is
important that the page numbers do not change when a new page is inserted. If you know
this beforehand, you can insert reserved pages in advance. When printing, these reserved
pages are simply skipped so that they do not use up paper unnecessarily. 

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

Select, Move and Delete Elements
 
Select
After you have drawn the elements you want, you can change them at any time. You can
move them, change their size or shape, choose new colors, etc. To change an element, you
must first select it. If you have not already done so, switch back to standard mode. Then
simply click on the desired element with the mouse. If the element has no filling, e.g. a hollow
circle, then please click on the edge of the element.

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com
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You can recognize selected elements at any time by their color scheme (magenta) and the
small green/black box sizers around them.

Select several elements
Sometimes it is necessary to select several elements at once. To do this, please click with
the mouse on an empty space in the drawing. Then draw a frame with the mouse button still
held down. When you let go of the mouse, all elements that lie within or only partially within
the frame are selected.

For particularly tricky selections, you can also work with the <SHIFT> key. If you keep this
pressed, you can select all the desired elements one after the other with the mouse without
losing the previous selection. You can also deselect a selected element by clicking on it. With
these functions you can easily create complicated selections.

Move
To move elements, they must first be selected. Then click with the mouse on one of the
selected elements (please not on the sizer or changer) and move it with the mouse to the
desired position. All other selected elements are also moved.

Tip:
You can also move the selected objects with the cursor keys on the keyboard. The
elements are shifted by one grid point in the desired direction. With the <CTRL> key you can
refine the grid by a factor of 10 and thus position it more finely using the keyboard.

Delete
To delete elements, they must first be selected. Then execute the "Delete" command. You
can reach this either via the "Edit" menu or directly with the "DEL" key on the keyboard.
Alternatively, you can also click the corresponding toolbar button. All selected elements will
be removed from your drawing.

Scaling, rotating and shearing
Selected elements can be scaled (changed in size), compressed and stretched, rotated or
sheared as required. You can do all of these functions easily with the mouse using the sizer
and changer.

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Sizer and Changer
 
Sizer
If an element (or several) is selected, you can recognize this by the fact that it is colored
magenta (pink) and surrounded by 8 black/green boxes, the so-called sizers. 

http://www.helpndoc.com/help-authoring-tool
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With these sizers you can freely scale the element. If you move the mouse over one of these
sizers, you will recognize the possible stretching direction from the changing mouse pointer.
Just click on the sizer you want and drag the mouse in the direction you want. The element
can be enlarged, reduced, compressed or stretched as required.

If you click again with the mouse on a selected element, the sizers change to arrows. 

 
With the arrows you can now turn and shear the element as you like. Use the 4 semicircular
corner arrows to turn. The angle of rotation always locks into the angle of rotation snap you
set. You set the rotation angle snap in the lower toolbar: 
 

 
Tip:
With the CTRL key you can temporarily switch off the angle of rotation snap at any time,
i.e. as long as you keep the key pressed.

Changer
Some drawing elements can also be changed with the help of the changer. These are only
visible if the corresponding element is selected on its own. 

 
 
The changers are small white boxes that lie on top of the element. Click on a changer and
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move the mouse until you reach the change you want. With the changers you can change
the following drawing elements:

Lines:
You can move the start, stop and nodess of the line. With a right-click on a sizer, you can
delete and insert nodes here, or split the line into two individual lines.

Polygons:
You can move all of the nodes of the polygon. With a click with the right mouse button on a
sizer you can delete or insert nodes here.

Bezier curves:
You can move the start and stop point as well as the control points of the bezier curve.

Circles:
You can freely determine the start and stop point of the circular outline. This gives you the
option of creating arcs or segments.

Rectangles:
You can determine the rounding of the corners. With this you can easily create oval shapes
or rounded rectangles, for example.

Dimensions:
You can redefine the positions of the extension lines.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Grid settings
 
When drawing with sPlan, a saved snap grid is normally always activated. With this snap grid
you can no longer move to all positions on the drawing, but only "jump" from one grid point to
the next grid point. This function is of great help for the exact positioning and connection of
components. You can see and change the grid width of this stored snap grid at any time in
the lower status bar.

On the screen, the grid becomes larger or smaller as you zoom in or out. If you zoom out too
far so that the individual grid lines would almost touch each other, the grid is automatically
hidden.

Incidentally, the grid is only ever visible on the monitor. This is not included in the printout.

The current grid is always displayed in the lower status bar: 

With a click on this grid value you can set it directly.

To change the optical properties of the snap grid, call up the General Settings dialog either
via the "General Settings ..." menu item in the "Settings" menu and then select the "Grid"
entry on the left, or simply click on the corresponding toolbar button. 
 

http://www.helpndoc.com/feature-tour
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Contrast:
Here you enter the display strength of the grid.
Depending on your monitor or your habits, you can use it to adapt the display of the grid to
your requirements.

Subdivisions:
This allows you to subdivide the grid again.
With a setting of "5", for example, every 5 grid lines are displayed a little stronger. This
makes orientation on the grid much easier, e.g. when counting.

Lines / Dots
Determines whether the grid is displayed in lines or dots.

Tip:
With the <CTRL> key you can temporarily switch off the grid snap at any time, i.e. as long
as you keep the key pressed. This is sometimes helpful, especially in tricky areas.

If you want to work without the grid snap for a longer period of time, you can deactivate it
with the button in the lower status line. 

 

Your grid settings are retained, only the snap is deactivated.
To reactivate the grid snap, simply click the same button again. 

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

The lower Statusbar

The statusbar is located at the bottom of the sPlan window: 

http://www.helpndoc.com
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Here you can read the current mouse coordinates at any time, but also make some settings: 

The current Scale.
Click here to change the scale in the properties panel. 

The current grid and the current zoom factor.
Click here to change these values. 

   
Here you can switch the grid snap on / off.
You can also temporarily deactivate the grid snap at any time with the <CTRL> key.

   
Here you can switch the angle snap on / off when drawing lines.
With the <SHIFT> key you can temporarily deactivate the angle snap when drawing lines at
any time. 

   
Here you can switch the connection snap on / off.
With the <ALT> key you can deactivate the connection snap at any time for a short time.

The connection snap is a very helpful function of sPlan. In addition to the grid snap, this
function activates an automatic snap to all connections. All nodes of lines as well as the
start and end points of circular arcs and bezier curves are to be understood as connection
points here.
As soon as the mouse position approaches a connection point during corresponding actions,
the connection snap captures the mouse position. A red circle will then be displayed around
the connection point to indicate that the mouse position has been captured by a connector.
With the help of the connection snap, exact connections can be made quickly and safely. 

   
Here you can switch the rubber band function on / off.
The rubber band function is intended to help hold connections in the drawing together when
individual components or elements are moved. If a connected component is moved and the
rubber band function is activated, all connection lines are taken along by the component.

sPlan can only clearly recognize lines on the components if they are correctly connected. If
the lines overlap the component connection, they are not recognized as "connected" and are
therefore not included. Likewise, the rubber band function cannot work if 2 components are
connected directly, i.e. without a cable. Then there is no line that could take the rubber
band function with it.

After a component and its connections have been moved, the connection lines often have to
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be reworked. If you select the line, you can move all nodes of the line with the changers.
You can also remove or add individual nodes. To do this, right-click on a changer that
represents the nodes of the line. Then you get a small menu in which you can remove the
point or insert another point. 

Here you can set the rotational angle snap.
The rotational angle snap determines the grid of the rotation angle when you freely rotate a
component or an element with the mouse.
With the <CTRL> key you can deactivate the angle of rotation snap at any time briefly and
thus rotate the element freely. 

   
With this you determine the behavior of texts when they are rotated together with other
elements.
The text is either always completely rotated, or only the text position is rotated. 

   
With this you determine the behavior of texts when they are mirrored together with other
elements.
The text is either always completely reflected, or only the text position is reflected. 

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Drawing functions
 
With sPlan you have all the elementary drawing functions you need to create sophisticated
drawings:
 

· Lines
· Connections
· Rectangles, rounded rectangle
· Circles, circle segments
· Polygon (closed area with or without filling)
· Bezier curves
· Freehand lines
· Special forms (polygons, stars, tables, sine curves,...)
· Dimensions
· Text (simple text label)
· TextRect (multiline text for larger texts and descriptions)
· Bitmaps (for inserting logos or other graphics)

A separate mode is available for each of these elements. Use the button bar (between the
library and the drawing area) to select the desired mode.

To select, edit and move the elements, please switch back to standard mode again. A click
with the RIGHT mouse button on the drawing or with the <ESC> key is sufficient.

http://www.helpndoc.com
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Tip:
The drawing area has its own local menu (context menu). You can do this by moving the
mouse to the drawing area and clicking the RIGHT mouse button once. The local menu
gives you quicker and more convenient access to many commands. 

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Drawing functions

 
With sPlan you have all the elementary drawing functions you need to create sophisticated
drawings:
 

· Lines
· Connections
· Rectangles, rounded Rectangles
· Circles, Ellipses or Circle segments
· Polygon (closed area with or without filling)
· Bezier curves
· Freehand lines
· Special forms (polygons, stars, tables, sine curves,...)
· Dimensions
· Text (simple text label)
· TextRect (multiline text for larger texts and descriptions)
· Bitmaps (for inserting logos or other graphics)

A separate mode is available for each of these elements. Use the button bar (between the
library and the drawing area) to select the desired mode.

To select, edit and move the elements, please switch back to standard mode again. A click
with the RIGHT mouse button on the drawing or with the <ESC> key is sufficient.

Tip:
The drawing area has its own local menu (context menu). You can do this by moving the
mouse to the drawing area and clicking the RIGHT mouse button once. The local menu
gives you quicker and more convenient access to many commands. 

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Lines

 

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com
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Drawing a new line
 

 Select the appropriate drawing mode.

Click with the mouse on the drawing to determine the starting point of the line and then
release the mouse button again. Now click on the next desired corner point of the line and
release the mouse button. You can "lay" your line over any number of corner points.

To stop drawing the line, click the right mouse button once. You can now start a new line or
switch back to standard mode by clicking the right mouse button again.

The line is initially always created with the preset properties for a line (width, color, etc.).
If you have selected the line mode but have not yet started drawing, you can change these
preset properties here directly.

Change an existing line
If you select a line on the drawing, you can use the sizers to change its size, shape and
direction of rotation at any time. With the changers you can move all nodes of the line. So
you can easily change the line afterwards. 
 

 
 
 
You can also create new additional nodes at a later date. For this, there is a so-called 
virtual node in the middle of each line segment, shown as a blue dot. If you click on it and
move it, this virtual node becomes a new real node. So you can interactively expand your
line with new nodes.

You can also remove individual nodes or split the line into 2 parts. To do this, right-click on a
node. Then you get a small menu in which you can remove the node, among other things.
You can also split the line at this position here and thus get 2 individual lines.

Change the properties of lines
If you select a line, you can set its properties in the properties panel on the right edge of the
window. You can also select several lines at the same time and thus change their properties
together. 

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Connections

Connections are the connection points in a drawing. They indicate whether 2 crossing lines
are electrically connected. 

http://www.helpndoc.com/help-authoring-tool
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Place a new connection

 Select the appropriate drawing mode.

Click with the mouse on the drawing to set a new solder point at this position. With every
further click you can now set further solder points. To exit the soldering point mode, click
once on the right mouse button.

A connection is initially always created with the preset properties for the solder point.
If you have selected the solder point mode, you can change these preset properties directly
in the properties panel. 

To delete a solder point, select it and press the <ENTF> key. 

Change properties of connections
If you select a connection, you can set its properties in the properties panel on the right
edge of the window. You can also select several connections at the same time and thus
change their properties together.

Automatic
The automatic function is a special setting. If this function is activated for a connection,
the connection automatically adapts to the line on which it lies in terms of size and color. So
if you change the line width or the line color, the connection also changes automatically.
With Auto-Size you can define the adjustment of the connection to the line width. 

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Rectangles, rounded Rectangles

 
 
Drawing a new rectangle
 

 Select the appropriate drawing mode.

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com/help-authoring-tool
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With a click on the small triangle you can choose whether you want to draw out the
rectangle as a frame (starting point above / left) or from where the starting point determines
the center of the rectangle.

Now click with the mouse on the drawing to determine the starting point of the rectangle.
Now, with the mouse button held down, draw a frame with the mouse to determine its size
and shape. When you release the mouse button, the rectangle is created as an element on
your drawing.

If you hold down the <SHIFT> key while drawing, you will force a proportional aspect ratio,
i.e. a square.

The rectangle is initially always created with the preset properties for an area (outline and
filling).
If you have selected the rectangle mode but have not yet started drawing, you can change
these preset properties here directly.

Modifying an existing rectangle
If you select a rectangle, you can use the sizers to change its size, shape and direction of
rotation at any time. 

With the changer you can adjust the roundness of the rectangle and thus create rounded
rectangles or ovals.

Change the properties of rectangles
If you select a rectangle, you can set its properties in the properties panel on the right edge
of the window. You can also select several rectangles at the same time and thus change
their properties together. 

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Circles, Ellipses or Circle segments

 

http://www.helpndoc.com/help-authoring-tool
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Drawing a new circle or ellipse
 

 Select the appropriate drawing mode.

With a click on the small triangle you can choose whether you want to draw the circle as a
frame (starting point above / left) or from where the starting point determines the center of
the circle.

Click with the mouse on the drawing to determine the starting point of the circle. Now, with
the mouse button held down, draw a frame with the mouse to determine its size and shape.
When you release the mouse button, the circle is created as an element on your drawing.

If you hold down the <SHIFT> key while drawing, you will force a proportional aspect ratio,
i.e. an exact circle instead of an ellipse.

The circle is initially always created with the preset properties for an area (outline and filling)
.
If you have selected the circle mode but have not yet started drawing, you can change
these preset properties here directly.

Change an existing circle / arc
If you select a circle on the drawing, you can use the sizers to change its size, shape and
direction of rotation at any time.

With the changers you can determine the start and stop point of the circular outline. In this
way you can create arcs or segments (with filled circles).

Change the properties of circles / arcs
If you select a circle, you can set its properties in the properties panel on the right edge of
the window. You can also select several circles at the same time and thus change their
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properties together. 

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Polygons (closed areas)

 

 
 
Draw a new polygon
 

 Select the appropriate drawing mode.

Click with the mouse on the drawing to determine the starting point of the polygon and then
release the mouse button again. Now click on the next desired corner point of the polygon
and release the mouse button. This is how you create your polygon using any number of
corner points.

To end the polygon drawing, click once on the right mouse button. The polygon is
automatically closed. You can now start a new polygon or switch directly back to standard
mode by clicking the right mouse button again.

The polygon is initially always created with the preset properties for an area (outline and
filling).
If you have selected the polygon mode but have not yet started drawing, you can change
these preset properties here directly.

Modify an existing polygon
When you select a polygon, you can use the sizers to change its size, shape and direction of
rotation at any time. With the changers you can move all nodes of the polygon. So you can
easily change the polygon later.
 

 

http://www.helpndoc.com
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You can also create new additional nodes at a later date. For this, there is a so-called 
virtual node in the middle of each line segment, shown as a blue circle. If you click on it and
move it, this virtual node becomes a new real node. So you can interactively expand your
line with new nodes.

You can also remove individual nodes. To do this, right-click on a node. Then you get a
small menu in which you can remove the node, among other things.

Change the properties of polygons
If you select a polygon, you can set its properties in the properties panel on the right edge
of the window. You can also select several polygons at the same time and thus change their
properties together. 
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Bezier curves

Bezier curves are special curves that each consist of a start point, 2 control points and an
end point. The curve begins at the start point and ends at the end point. The two control
points determine the shape of the curve. 

 
A simple bezier curve always consists of exactly 4 points. You can also define several curves
in one go. The end point of the last curve is then automatically used as the starting point of
the next curve, so that 3 points (2 control points and 1 end point) are sufficient for each
additional curve. bezier curves therefore always consist of at least 4 points and 3 points for
each additional curve, i.e. either 4,7,10,13, ... points in total. 

 
Draw a new bezier curve
 

 To draw a bezier curve, select the appropriate drawing mode.
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Click with the mouse on the drawing to determine the starting point of the curve and then
release the mouse button again. Now determine the two control points of the curve with
further mouse clicks and then the end point. For another curve you then define 2 further
control points and the end point. To end the curve drawing, click once on the right mouse
button. You can now start a new curve.

When setting the control points for a bezier curve, the curve cannot yet be displayed on the
screen because the final shape of the curve still depends on the end point. But this is not a
big deal, because the control points can then be moved as desired, and the desired shape of
the curve can be precisely set.

The bezier curve is initially always created with the preset properties for a line (width, color,
etc.).
If you have selected the bezier curve mode but have not yet started drawing, you can
change these preset properties here directly.

Change an existing bezier curve
If you select a bezier curve on the drawing, you can use the sizers to change its size, shape
and direction of rotation at any time. With the changers you can move all nodes of the
curve. So you can easily change the line afterwards.

Change the properties of bezier curves
If you select a bezier curve, you can set its properties in the properties panel on the right
edge of the window. You can also select several bezier curves at the same time and thus
change their properties together.
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Freehand Lines

Freehand lines are special lines that are drawn "freehand", so to speak, with the mouse. 

Draw a new freehand line
 

 Select the appropriate drawing mode.

Click with the mouse on the drawing to determine the starting point of the freehand line. Hold
down the mouse button and now draw the freehand line. Release the mouse button and the
freehand line is done.

The freehand line is always initially created with the preset properties for a line (width, color,
etc.).
If you have selected the freehand line mode but have not yet started drawing, you can
change these preset properties here directly.
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Modify an existing freehand line
If you select a freehand line on the drawing, you can use the sizers to change its size, shape
and direction of rotation at any time. With the changers you can move all nodes of the line.
You can also change the freehand line later. Since a freehand line usually consists of a large
number of nodes, you can zoom into these and edit the individual nodes more precisely if
necessary.

 
You can also create new additional nodes at a later date. For this, there is a so-called 
virtual node in the middle of each line segment, shown as a blue circle. If you click on it and
move it, this virtual node becomes a new real node. So you can interactively expand your
line with new nodes.

You can also remove individual nodes or split the line into 2 parts. To do this, right-click on a
node. Then you get a small menu in which you can remove the node, among other things.
You can also split the line at this position here and thus get 2 individual lines.

Change the properties of freehand lines
If you select a freehand line, you can set its properties in the properties panel on the right
edge of the window. You can also select several lines at the same time and thus change
their properties together. 
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Special Forms

 
The special forms are simple but often required and sometimes difficult to create elements.
Often these forms can also serve as a construction aid. For example, you can use an
equilateral polygon as a construction aid to arrange solder points in an exact circular shape.
To do this, simply create the polygon with the number of corners you want. Now place a
soldering point on each corner and then delete the polygon again. You have already aligned
your soldering points exactly in a circular shape. 
 

 
 
Create a new Special form
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 Select the appropriate drawing mode.

A pop-up menu opens and you can select the special form you want from the list.
With the first 4 special shapes, a dialog for setting special properties also appears: 
 

With polygon and star you can choose whether the element should be created as a line or
as a polygon. If the element is to be given a fill color, you must select "as polygon".

After selecting the special shape (and possibly confirming the dialog with OK), you can place
the selected special shape on the drawing with the mouse. To do this, click with the mouse
on the drawing to determine the starting point. Now, while still holding the mouse button
down, draw a frame with the mouse to determine its size. When you release the mouse
button, the special shape is created on the drawing. With some special shapes (such as
arrows) you can influence the shape with the direction in which you open the frame (to the
left / right or up / down).

Change an existing special shape
After creating a special shape, it is created from the basic elements of sPlan (line, polygon,
etc.).
So changing these elements is the same as changing these simple basic elements.
The special properties that were selected when the special shape was created are no longer
available after creation and cannot be changed afterwards. If necessary, the special shape
can simply be deleted and a new one created. 
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Dimensions

With the dimensioning functions of sPlan you can easily create various dimensions: 
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Depending on the type, a dimension consists of 2-3 control points. These control points are
set one after the other when creating a new dimension. The control points can then be
moved again at any time with the help of the changer. 
 
 
Draw a new dimension
 

 To create a new dimension, select the appropriate drawing mode.

Click on the small red triangle to open a small list from which you can choose a different
dimension type: 

You can now set the individual control points of the new dimension on the plan with a simple
mouse click, thus creating the new dimension. Move the mouse after each click to see the
effect of the control points. You will quickly see its effect. After the 2nd or 3rd click
(depending on the dimension type) the dimension is finished.
You can cancel the creation of a dimension at any time with the right mouse button.

The dimensions are initially always created with the preset properties for a dimension (color,
text type, arrows, etc.).
If you have selected the dimension mode but have not yet started drawing, you can change
these preset properties here directly.

Change an existing dimension
Select the desired dimension. 
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With the changers you can now reposition all nodes of the dimension. So you can easily
change the dimensions afterwards.

Change properties of dimensions
If you select a dimension, you can set its properties in the properties panel on the right edge
of the window. You can also select several dimensions at the same time and thus change
their properties together.

Some special properties of a dimension are briefly explained here:

Show diameter:
If activated, the diameter symbol appears in front of the numerical value.

Prefix:
Any text that comes before the numeric value.

Suffix:
Any text that appears after the numerical value (e.g. a "°" sign for angular dimensions).

Upper tolerance / Lower tolerance:
Here, as is sometimes necessary for special dimensions, the tolerances for a dimension can
be specified. The two tolerance specifications for positive and negative values are then,
according to the standard, at the top and bottom after the dimension figure.

Auto-Measure:
If Auto-Measure is activated, the numerical value is always set automatically when the
dimension is changed.
You can also enter your own fixed numerical value. The auto function must then be
deactivated for this.
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Text
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Create a new text label
 

 Select the appropriate drawing mode.

Click with the mouse on the drawing to place a text. You can now place further texts directly
with further mouse clicks or exit the text mode with the right mouse button. Now you can
directly adjust the properties (text, font, color, etc.) of the new text.

Change an existing text
If you select a text on the drawing, you can use the sizers to change its size, shape and
direction of rotation at any time. 

 

Advanced text entry
With a double click on the text, or with the head "..." next to the text input in the properties
panel, you can call up the extended text edit

Change the properties of texts
If you select a text, you can set its properties in the properties panel on the right edge of
the window. You can also select several texts at the same time and thus change their
properties together.

Text linking
In the properties you can also make the settings for internal or external text links.
Here you can find more information about the text links. 
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Extended Text Edit

With a double click on the text, or with the button "..." next to the text input in the
properties panel, you can call up the Extended text edit:
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Here you can change the text or insert variables or text constants into the text.
With the button "Ω" you can call up the special characters dialog: 

Here you will find all characters that are available in the currently selected character set
(Unicode), including those that cannot be accessed directly via the keyboard.

If you double-click on a character, it will automatically be included in the text input. 
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TextRect (multiline)
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Create a new TextRect 
 

 Select the appropriate mode switch.

Click with the mouse on the drawing in order to determine the starting point of the TextRect.
Now, while keeping the mouse button pressed, draw a frame with the mouse to determine its
size. When you release the mouse button, the TextRect is placed on your drawing. You can
now directly create further TextRects or exit the TextRect mode with the right mouse
button. Now you can directly adjust the properties (text, font, color, etc.) of the new
TextRect.

Change an existing TextRect
If you select a TextRect on the drawing, you can use the sizers to change its size, shape
and direction of rotation at any time. 

 

Change properties of TextRects
If you select a TextRect, you can set its properties in the properties panel on the right edge
of the window. You can also select several TextRects at the same time and thus change
their properties together.

Tip:
Press the key combination <Ctrl> + <Ins> in the input field of the paragraph text to call
up the special characters dialog. 
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Here you will find all characters that are available in the currently selected character set
(Unicode), including those that cannot be accessed directly via the keyboard.

If you double-click on a character, it will automatically be included in the text. 

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Bitmaps

 

 Select the appropriate drawing mode.

An "Open" dialog appears in which you can select the desired bitmap. sPlan supports bitmaps
in * .BMP or * .JPG format. If you would like to read in other formats (such as GIF, PNG or
PDF), you must first convert them to the BMP or JPG format using an appropriate graphics
program.

After you have selected a bitmap, the graphic is imported into your schematic.

As an alternative to this procedure, you can also execute the "Import picture from file..."
command from the "File" menu.

Change an existing bitmap
If you select a bitmap on the drawing, you can use the sizers to change its size, shape and
direction of rotation at any time. 
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Properties of bitmaps / special functions
When you select a bitmap, you can see its properties (memory requirements, size, resolution,
etc.) in the properties panel on the right-hand side of the window.

There are also some special functions here:

Reduce resolution
This allows you to reduce the internal resolution of the integrated bitmap by a factor of 1.4.
Especially when a bitmap is shown relatively small on the plan, its resolution is often much
too large.
If the resolution of your bitmap is more than 300 dpi, you can usually reduce the resolution of
the integrated bitmap here in order to avoid unnecessarily high memory usage. If necessary,
you can also perform this function several times in a row. Note how much the memory
requirement decreases!
If the resolution of the bitmap is very high, this button is highlighted in red to indicate this
directly.

Rotate bitmap 90°
This allows you to rotate the internal bitmap directly (physically, so to speak) by 90°
clockwise.
You could simply rotate the bitmap on the drawing, but the internal bitmap remains
untouched (i.e. not rotated) and sPlan must first rotate the bitmap "software-wise" in order
to display it correctly every time the bitmap is displayed on the monitor and also on the
printer . This costs unnecessary computing power and can sometimes even lead to problems
when printing.

Lighten up
If a bitmap appears too dark, you can use this to lighten it a little. If necessary, you can also
perform this function several times in a row.

Normalize
With this you can bring a possibly "distorted" bitmap back to its original proportions.

Bitmap-Explorer
This opens the Bitmap-Explorer.
All bitmaps used in your project are listed in the Bitmap-Explorer. In this way you can quickly
get an overview of all bitmaps, their resolution and their memory requirements.

Here you can directly specify a maximum value for the resolution (DPI) of the bitmaps and
automatically adjust all bitmaps with a higher resolution to this maximum value. Depending on
the bitmaps used, this can save a lot of memory and thus make your sPlan project narrower
and faster.
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Clipboard functions
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The clipboard is a useful tool in almost all Windows programs. You can also use these
functions with sPlan. The clipboard is like a container in which you can store elements of
your drawing and access them again later. You can use the clipboard with the following
commands:

· Cutting out
· Copy
· Paste
· Duplicate

You can find these commands in the "Edit" menu or in the local pop-up menu (right-click on
the drawing). A corresponding button in the toolbar is dedicated to each command. The
individual commands have the following meanings.

Cut
Copies all selected elements from your drawing to the clipboard. The selected elements are
then deleted from your drawing.

Copy
Copies all selected elements from your drawing to the clipboard. In contrast to cutting,
however, the selected elements remain on your drawing.

Insert
Inserts the contents of the clipboard onto your drawing. An image of the elements to be
inserted "sticks" at the mouse position. With a click of the mouse, the elements are inserted
at the corresponding point in the drawing.

Duplicate
Duplicating copies all selected elements to the clipboard and inserts them again from there.

For further processing in other programs (e.g. for documentation in word processing), sPlan
can copy the drawing as a graphic to the clipboard. For more information, see Copy a
Drawing to the Clipboard.
Copy a Drawing to the Clipboard
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Copy a Drawing to the Clipboard
 
For further processing in other programs (e.g. for documentation in word processing), sPlan
can copy the drawing as a graphic to the clipboard. Other programs can then import this
graphic using the Paste command.

To copy your drawing to the clipboard as a graphic, select Clipboard... from the File menu. 
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Resolution
Here you select the desired resolution.
The higher the resolution, the better the quality of the graphic. However, the internal
memory requirements also increase. Since Windows limits the size of the clipboard for
graphics, problems can arise with very large drawings and high resolutions. In this case,
reduce the resolution.

Selection
Here you can choose whether you want to copy the entire drawing or only the selected part
of your drawing to the clipboard. 
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Rotate,  Mirror, Set to front / back

All elements on the drawing can be rotated, mirrored or changed in their Z-order (above /
below one another). The following commands are available for this:

· Rotate
· Flip horizontally
· Flip vertically
· Set to front
· Set to back

You can find these commands in the "Functions" menu, in the local pop-up menu (right-
click on the drawing) or in the toolbar.
First select the elements on which you want to apply these functions and then call the
function.

Rotate (90°)

 With the button in the toolbar, all selected elements are rotated 90 ° clockwise.

Rotate

With the menu item "Rotate ..." in the "Functions" menu, or in the local pop-up menu
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(right mouse click on the drawing), all selected elements are rotated clockwise by an
adjustable angle. 

Individual elements as well as complete drawing parts can be rotated.

You can also simply rotate selected elements with the mouse (see also Sizer and Changer)
If you click again with the mouse on an element that has already been selected, the sizers at
the 4 corners change to arrows. Now you can simply click on one of these arrows and rotate
the element with the mouse button still held down. 

The angle of rotation always locks into the angle of rotation snap you set. You set the
rotation angle snap in the lower toolbar: 

Tip:
With the <CTRL> key you can temporarily switch off the angle of rotation snap at any time,
i.e. as long as you keep the key pressed.

If texts are also rotated, you can determine the rotation behavior of these texts with the
button in the lower toolbar. With a click on this button you can change the turning
behavior: 

  

Either the texts always stay in the same text orientation when rotating, or the text
orientation is rotated together with the text: 

 

Mirror
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With the two toolbar buttons or with the menu items "Mirror horizontal / Mirror vertical"
in the "Functions" menu or in the local pop-up menu (right click on the drawing), all
selected elements are mirrored either horizontally or vertically.

If texts are also mirrored, you can determine the mirroring behavior of these texts with the
button in the lower toolbar. With a click on this button you can change the mirror behavior:

  

Either the texts themselves always remain the same when mirrored, or the texts are also
mirrored:

   

 
Set to front / Set to back

With the two toolbar buttons or with the menu items "Set to front / Set to back" in the
"Functions" menu or in the local pop-up menu (right click on the drawing), all selected
elements are set to front or back.

This allows you to determine the Z-order of the individual elements. The Z-order determines
which elements are on top of which other elements. So if an element is completely or
partially covered by another element, and this element should lie above the other element,
you can bring it to the foreground with the "Set to front" function. It is then automatically on
top of all other elements. You can do exactly the opposite with the "Set to back" function.
This function sets the selected element all the way back so that it is covered by all other
elements. These functions also affect all selected elements. 
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Align Elements

You can use this function to automatically align several elements with one another.
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First, select the elements that you want to align. At least 2 elements must be selected.
Then select the "Align" button from the toolbar:

A menu then appears in which you can select the desired orientation. You have various
options here:

After you have chosen an alignment, all selected elements are aligned as required 
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Colorize Elements
 
With this function you can color certain areas of your drawing without having to change the
colors individually for each element.

To colorize, first select the desired elements on your drawing and then select the entry 
"Colorize elements..." from the "Functions" menu.

A color selection box then appears in which you can select the desired color. After you have
confirmed the color selection, the selected elements are colored. You do not see this
immediately because the corresponding elements are still selected and are therefore still
displayed in magenta. However, if you deselect it, you will see that the elements have been
colored in the selected color.

All lines and fills are set to the selected color. An exception is a white filling. This is always
retained. This makes sense because many more complex components have e.g. a white box
in which there are further elements or texts. If the white filling would also be colored, you
would not be able to see anything here. When components are filled, they usually have a
white filling. 

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Build / Split Groups
 
You can combine several elements of the drawing into a group. This has the advantage that
you can completely select, move or otherwise edit all elements of the group with just one
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click. In addition, the elements contained in the group are protected against accidental
changes. Individual elements cannot be deleted from a group. Each group always consists of
at least two elements. Multi-level groupings are also possible, which means that different
groups can be combined again to form one group.

It may be necessary to break down an existing group into its components, e.g. to delete or
change a single element from it. When a group is dissolved, only the top level of the grouping
is canceled, i.e. any previously existing subgroups are retained. If necessary, repeat the
process for the subgroups.

The two necessary functions are available to you with the "Build group" and "Split group"
commands.
You can find these commands in the "Functions" menu, or in the local pop-up menu (right-
click on the drawing) or in the toolbar.

First select the elements on which you want to apply these functions and then call the
function.

Tip:
If you click on an element in a group while holding down the <ALT> key, you can also select
it individually. This can be very helpful in some cases. For example, you can change the
properties of an element within a group without breaking the grouping beforehand. 
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Magnetic Lines

You have the option of positioning so-called "magnetic lines" on the drawing. These can be
helpful when creating the drawings. Magnetic lines are purely construction aids and are
neither printed out, nor can they be edited in any way. You can create, move and delete
these lines. The advantage of these lines is that they "magnetically attract" all elements. As
soon as you move an element and with it come close to such a magnetic line, it will be
attracted to it. This can be used to align several elements on exactly one line, for example.
With several such lines, table-like structures could also be designed.

Insert new magnetic lines
With the commands "New vertical magnetic line" and "New horizontal magnetic line" in the
submenu "Functions -> Magnetic lines" you can create a new magnetic line. From there,
these auxiliary lines can be moved as desired.

You can also simply draw magnetic lines from the rulers more easily and quickly. Simply click
on the ruler with the mouse, hold the mouse button down and drag a magnetic line onto the
drawing.

Moving magnetic lines
If you move the mouse over a magnetic line, the mouse pointer changes into a double arrow.
This is the sign that you can move the magnetic line here. Click with the mouse on the
corresponding magnetic line and then drag it to the desired position while holding the mouse
button down.

Deleting magnetic lines
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To delete an magnetic line, click with the mouse once on the magnetic line to be deleted.
This will then turn red. With the command "Delete" (menu "Edit" or toolbar) you can now
delete this magnetic line again.

You can delete magnetic lines more easily and quickly by simply dragging them onto a ruler.

Fix magnetic lines
With this function from the submenu "Functions-> Magnetic Lines" you can fix all magnetic
lines on the drawing. These are then automatically protected against being moved and
deleted. You cannot add new magnetic lines in this mode either. You can exit the mode at
any time by selecting this function again.

Hide magnetic lines
With this function from the submenu "Functions-> Magnetic Lines" you can hide all
magnetic lines on the drawing. You cannot add new magnetic lines in this mode either. You
can show the magnetic lines again at any time by selecting this function again.
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Using Forms
 
Each drawing in sPlan can have its own form. The form is, so to speak, a separate drawing
level that lies below the actual drawing. In the normal working mode, the form is only visible
visually, but you cannot select or edit any elements of the form. In this way, the form in the
background does not interfere with normal work with sPlan.

You can create your own new forms or change existing forms according to your
requirements.

Edit form level

If you want to edit the current form or create a new one, you must first release the form
level for editing. To do this, select the Edit form layer command in the Forms menu, or
click the corresponding button in the toolbar. The drawing is now hidden and the form is
released for editing. You can now design the form as you like. While you are working on the
form, all of the drawing functions of sPlan are available to you as normal.

When you have finished editing the form, deactivate the Edit form layer option again by
clicking on Exit or by clicking the menu item again. Now the form is put back and the drawing
is visible again. You are now back in the normal editing mode for the drawing.

http://www.helpndoc.com
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Save form
You can save the current form as a separate file at any time. The form is then also available
for loading for all other pages. To save forms, select the Save form to file... command from
the Forms menu. All forms are automatically given the extension * .SBK.

Load form
If you want to load an existing form for a page, select the Load form from file... command
from the Forms menu. Please note that when a new form is loaded, any existing form will be
lost.

Remove the form
If you want to remove a form from a schematic, select the command Remove form... from
the Forms menu. Here you can also remove forms from several or from all pages of your
project.

Generate form automatically
If no element is selected, the properties of the page are displayed in the properties panel on
the right edge of the window. Here there is the Form section with which you can generate a
form automatically:

The form is first divided into a kind of grid. Here you can specify the total size of the form as
well as the offset and the number of columns and rows in the grid. If you activate the Show
grid option, this grid will be displayed on your page, so you can also visually check the
individual parameters here.

This grid also determines the content of the following variables:

<COLNUM>
<COLCHAR>
<ROWNUM>
<ROWCHAR>
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With these variables, components can automatically display their position (column and/or row
on the form). This is particularly common for electrical installation plans.

When you have made the required settings, click on Generate... and after a further dialog
for defining the frame labeling of the form, it will then be generated automatically. 
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Multi-Page Projects
 
A project can consist of several single pages under sPlan. For example, it makes perfect
sense to split up a large drawing, if possible, into several small drawings, which are then all
placed on a single page. For example, the circuit of a complex audio amplifier could be divided
into the following individual plans:

· Power adapter
· Entrance level
· tone control
· power amplifier

The 4 individual pages would then all be stored in a sPlan file called "Amplifier.spl8", for
example.

You can create any number of single pages within a project (i.e. in one file). Each page has
its own name and the corresponding drawing. Each page has its own "tab" with the name of
the page at the bottom of the drawing area. You can then switch to the corresponding page
by clicking on the respective tab.
You can also determine the order of the pages afterwards, e.g. to sort the individual pages
according to priorities or similar.
You can save and load individual pages from a drawing separately. This gives you the option
of transferring certain pages from a complex circuit to other projects.

The "tab-list" below the drawing area has its own local menu (context menu). You can do
this by moving the mouse over this tab-list and clicking the right mouse button once. The
local menu gives you quick and easy access to many commands:

Page Properties...
Directly calls up the properties of the page in the properties-panel on the right edge of
the window. See also page settings.

Create new page...
This allows you to add a new page. You can freely determine the position of the new
page in a small dialog:
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Copy page...
With this you can copy a page within a project. You can freely determine the position
and number of copies in a small dialog:

Delete pages...
This deletes a page from the project. If you confirm the subsequent security question,
the page will be irrevocably deleted.
By the way, if you only have one page in your project, you cannot delete it. Each project
must consist of at least one page.

Sort pages...
If you want to change the order of the individual pages, you can use the "Sort pages..."
command. Here you can easily re-sort the individual pages in a list using drag & drop.

Load page from file / Save page to file
You will not find these two commands in the local context menu of the page bar but only in
the main menu under Page -> Load page from file... and Page -> Save page to file... 
If you would like to have a single page in a different file, you can save it separately. You can
then later reload the page from any other project file. Saved pages have the extension *
.BLT.

 Goto page...
Navigating in the page tab-list can sometimes be tedious, especially in projects with many
pages. To quickly go to a specific page, just click this arrow and select the page from the
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page list.

 Add page quickly
With this you can add a new page quick and easy, bypassing the extra dialog.

Vertical page list
Particularly for large projects with a large number of pages, a vertical page list can be clearer
than the conventional arrangement of the pages in the tab-list below the plan. At the top/
right in the toolbar there is a button to switch between the page-list modes:

With this you can easily switch back and forth between the conventional page tab-list and
the vertical page list. 

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Zooming

Zooming is a very important feature of sPlan. Only then is it possible to look at the complete
drawing first, but then to edit a particularly tricky, narrow area in large format in the next
moment.

Zoom with the mouse wheel
The easiest and most convenient way to zoom and navigate is to use the scroll wheel on
your mouse.
When the mouse is on the work surface of your plan, you can zoom with the scroll wheel.
When entering, the current mouse position is automatically placed in the middle of the work
surface. So you can always zoom in and out to all desired areas of your plan with a little
zooming in and out.

Panning (move visible view)
In panning-mode, you can move the visible view freely in all directions simply with the mouse.
You can reach the panning-mode in 2 different ways:

· Double-click on an empty space on the page.
Simply double-click on an empty spot, hold down the mouse and move the visible view
with the mouse.

· With the middle mouse button (mouse wheel).
Simply click with the middle mouse button, hold down the mouse and move the visible
view with the mouse.

The panning-mode ends as soon as you release the mouse button. 

The zoom mode
If you cannot or do not want to zoom with the mouse wheel, sPlan also has its own zoom
mode:

http://www.helpndoc.com
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The mouse then turns into a magnifying glass over the drawing. With a click on the left
mouse button you can now zoom into the drawing, with a click on the right mouse button
you zoom out again.

When zooming in, you can determine the center of the image for the next zoom level with
the left-click position. In this way you can move to the desired area quickly and precisely.

You can also "frame" the area you want. To do this, click with the left mouse button and
while still holding the button, drag the frame accordingly. After releasing the mouse button,
the framed area is displayed zoomed.
When you have reached the largest or smallest zoom level, further zoom attempts have no
effect.

There are 3 special zoom functions:

· Zoom page (zooms so that the whole page is visible)
· Zoom elements (zooms to all elements)
· Zoom selected elements (zooms to all selected elements)

You call up these zoom functions with the magnifying glass symbol in the upper toolbar. 

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

http://www.helpndoc.com/help-authoring-tool


44 / 104

General Settings

In the General settings you make general settings about the appearance and operation of
sPlan.
You call this dialog in the main menu under Settings -> General settings...

Use the individual entries on the left to select the respective category:

General Settings
Display
Directories
Library
Grid
AutoSave
New page
Hotkeys

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
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General Settings

Here you can make general settings for working with sPlan.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry General Settings from the left bar. 

Pages with page numbers
If this option is selected, all pages are automatically prefixed with the page number.

Components with page numbers
If this option is selected, all component identifiers are automatically preceded by the page
number.

http://www.helpndoc.com/help-authoring-tool
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Prefix
The prefix, if specified, is preceded by all component identifiers.

Use dialogs instead of the property-panel (old style)
If this option is selected and the properties-panel on the right is hidden, the properties of an
element are only displayed in a dialog with a double click on the element, as was always the
case with earlier versions of sPlan. There is actually no reason for this option, unless you
absolutely cannot get used to the new permanent property bar.

Component texts can only be moved with pressed <ALT> key
Normally you can click the component texts (identifier, value, contacts) directly on the plan
and move them independently of the component (provided that the component itself is not
selected). If you activate this option, this is only possible in connection with the <ALT> key.
Otherwise, when you click on a component text, the entire component is selected.

Use buffered file access
This option can speed up saving and loading files, especially when working on network drives.

Compress embedded bitmaps when saving
If this option is selected, inserted bitmaps (BMP or JPG) are saved in compressed form when
they are saved.
This drastically reduces the file size of the SPL files depending on the number and size of the
bitmaps used.

Handle bitmaps as DDB instead of DIB
If there is a memory problem with sPlan files with too many and too large bitmaps, this option
can bring an improvement on some systems.
In general, however, an sPlan file should never contain so many bitmaps that such memory
problems occur at all. Make sure that the inserted bitmaps do not have an unnecessarily high
resolution. A resolution of 300 dpi is sufficient in most cases. You can use the Bitmap
Explorer to examine the bitmaps in your file.

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Display

Here you make basic settings for the graphics and scaling of sPlan.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry Display from the left bar. 

http://www.helpndoc.com/help-authoring-tool
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Graphics engine

Use new graphics engine (Direct2D)
This is the standard setting of sPlan and should only be changed in the event of problems.
The new Direct2D technology is many times faster and more effective than the old GDI
technology.

Use GDI points
With this option, some lines and edges are sometimes displayed a little sharper, especially
with plans that have been zoomed in, thanks to a special grid. However, this is partly at
the expense of accuracy, so some lines may look slightly offset. If you are bothered by
the slightly blurred display when the plans are zoomed in, then you can give this option a
try.

Use old graphics engine (GDI)
This option should really only be activated in the event of problems with Direct2D and is no
longer recommended.

Smooth text
With this, the text is displayed smoothly when the display is zoomed in small.

Scaling

The complete sPlan interface can be displayed on your monitor in various scales (sizes).

Automatically
This is the standard specification of sPlan. The degree of scaling is based on the value set in
your Windows system.

None (100%)
This prevents any scaling in sPlan. This setting can result in sPlan being displayed very small
on your monitor.
Since not all elements can be scaled independently in Windows, different scaling may occur.

125%, 150%, ...
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This will scale sPlan to the specified value regardless of the value set in your Windows
system.
Since not all elements can be scaled independently in Windows, different scalings may occur.

Also scale toolbar bitmaps
If this option is activated, the small images on the toolbar buttons are also scaled and
displayed larger. This also makes them a bit more "pixelated". 

White background

If you are bothered by the slightly colored background in sPlan, you can use this option to
set the background color to pure white.

Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator

Directories
 
When working with sPlan, you can make certain specifications for the working directories and
other special directories.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry Directories from the left bar. 

Working directories
If necessary, you can specify fixed directories for the file dialogs here.
If you leave the fields empty, sPlan remembers the last directories used and uses them again
the next time.

Fixed directories
If necessary, you can change the default directories for templates and forms here.
With the button Set to default these directories are reset to the default sPlan directories. 
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Library

Here you can change the library root directory of sPlan.

The entire component library of sPlan is stored in a root directory.
This directory contains all of the sPlan library files, sorted in subdirectories. Each library file
here corresponds to a library page. The library files have the extension * .lib and can contain
any number of component symbols.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry Library from the left bar. 

 
Change...
Here you can change the library root directory.
This makes sense, for example, if you want to move your library to a network drive.
The new selected directory must exist and should of course also contain the desired library
files.

Reset
This will reset the library root directory to its default value.

Explorer
This opens the library root directory directly in a Windows file window.
Here, experienced users can edit the library at file level and thus also adapt the directory
structure of the library to suit their own requirements.

More information about the component library 
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Grid
 
When drawing with sPlan, a snap grid is normally always activated. With this snap grid you
can no longer move to all positions on the drawing, but only "jump" from one grid point to the
next grid point. This function is of great help for the exact positioning and connection of
components. You can see and change the grid width of this stored snap grid at any time in
the lower status bar.

On the screen, the grid becomes larger or smaller as you zoom in or out. If you zoom out too
far so that the individual grid lines would almost touch each other, the grid is automatically
hidden.

Incidentally, the grid is only ever visible on the monitor. This is not included in the printout.

The current grid is always displayed in the lower status bar: 

With a click on this grid value you can set it directly.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry Grid from the left bar. 
 

 
Contrast:
Here you enter the display strength of the grid.
Depending on your monitor or your habits, you can use it to adapt the display of the grid to
your requirements.

Subdivisions:
You can use this to subdivide the grid again.
With a setting of "5", for example, every 5 grid lines are displayed a little stronger. This
makes orientation on the grid much easier, e.g. when counting.

Line / Dots
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Determines whether the grid is displayed in lines or points.

Display the grid OVER the form level
When this option is selected, the grid is drawn OVER the form level.
This is particularly helpful if, for example, you have stored a large bitmap as a background on
the form that would otherwise completely cover the grid. 

Tip:
With the <CTRL> key you can temporarily switch off the grid snap at any time, i.e. as long
as you keep the key pressed. This is sometimes helpful, especially in tricky areas.

If you want to work without the grid snap for a longer period of time, you can deactivate it
with the button in the lower status line.

 
 
Your grid settings are retained, only the snap is deactivated.
To reactivate the grid snap, simply click the same button again. 

Created with the Standard Edition of HelpNDoc: Full featured Help generator

Autosave
 
Here you can activate 2 additional security mechanisms that can protect against data loss in
certain cases.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry Autosave from the left bar: 
 

 
With the first option you can activate a function in which the currently open file is
automatically saved in a further backup file at regular intervals. The backup file has the same
file name as the original file, only the extension is ".bak" instead of ".spl8".
If for whatever reason the original file should be defective, rename the backup file to ".spl8"

http://www.helpndoc.com/feature-tour
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and try to open it.

The second option provides even more security against data loss. Every time a file is opened,
a copy of the original file is automatically saved as a backup file. This backup file always has
the status of the file when it was last opened. These backup files always have the name
"Backup_of_" followed by the original name of the file. 

Created with the Standard Edition of HelpNDoc: Easily create Help documents

New page

Here you can make specifications for the properties of a new page. Whenever you create a
new page in sPlan, these defaults are used.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry New page from the left bar. 

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Hotkeys

Here you can define hotkeys for the individual tool modes in sPlan. Each button in the
vertical tool bar can be assigned its own button. You can then select the corresponding tool
mode with the keyboard instead of the mouse.

You call up the settings dialog from the main menu under Settings -> General settings...
Then select the entry Hotkeys from the left bar. 

http://www.helpndoc.com/feature-tour
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Components

The components are of course the most important elements on a drawing. That is why the
processing and use of components occupy an important place at sPlan.

The component library is located on the left side of the program window. This contains all the
components available in this library, sorted by page. You can rearrange this library as you
wish: set up new pages, copy components from one page to another, rename pages or
delete them entirely, add new components, etc.

The individual pages of the library are arranged alphabetically in a drop-down list directly
above the library. Here you select the library page you want.

The components are simply dragged from the library onto the drawing (drag & drop). To do
this, click with the mouse on the desired component in the library. With the mouse button
still held down, drag the component to the desired position on the drawing. There you
release the mouse button again.
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What is a Component?
 
A component is actually just a special group of drawn elements. For example, the component
"resistor" consists in the simplest case only of a drawn rectangle with two lines at its ends,
which mark the connections. When these drawing elements are then combined into a
component, the following happens:

· 2 new text elements are automatically added (identifier and value)
· The drawing elements and the text elements are grouped

By definition, each component has the two text fields identifier and value. In our example,
the identifier could be, for example, "R1" and the value "1k". These texts can be freely
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defined by the user.

The individual components therefore "only" differ in their external appearance. In principle,
they all have the same structure.

The sPlan program also offers a few special options for components that make handling them
easier and more flexible:

· The text element identifier can be hidden if desired
· The text element Value can be hidden if desired
· You can have the identifier numbered (incremented) automatically
· The value can be automatically queried when dragging the component onto the drawing
· You can determine whether the component should be included in the components list or

not
· You can specify additional texts for the component when used in the components list
· You can enter a caption for the component in the library

The library does not necessarily have to contain only components as defined above. It is also
possible to add a symbol to the library as a clip. A clip is not a component, just a simple
group of drawing elements. Such a clip can be any symbol, a graphic or an entire circuit
part. The imagination knows no limits. (Who says that sPlan can only be used to draw
circuits?)

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Component Properties
 
You can change any component, whether in the library or on the schematic. If you want to
make basic settings on a component, it is better to edit the corresponding component in the
library. This is, so to speak, an original, i.e. all components that you drag from here onto the
drawing have the same properties. Conversely, if you only want to change one component
once, it is better to edit the corresponding component on the drawing. This leaves the
"original" in the library untouched.

To change a component, call up its properties.

· On the drawing, it is sufficient to select the component with a mouse click.
· To edit a library component, double-click the component in the library. The component is

now highlighted as "selected" in color.

The properties of the component are now displayed in the properties panel on the right-hand
edge of the window: 

http://www.helpndoc.com/help-authoring-tool
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Identifier
The identifier is the identification letter of the component followed by a serial number (e.g.
"R1"). You can either enter this identifier manually for each component, or you can use the
very helpful automatic renumbering option.

visible
With this option you can show or hide the identifier of the component. This option can be
useful for some components that have no identifier at all, or that are perhaps not actually
components at all.

automatic numbering
With this option you leave the numbering completely to the program. As an identifier,
please enter e.g. only the "R" (without a consecutive number!). The software then
considers all components on the drawing that also have the identifier "R" (and have also
activated the automatic renumbering option) as belonging together and automatically
attaches the consecutive numbers to the identifier.

When you delete components on the drawing, there are gaps in the automatic component
numbering. To close this again, you can have the software renumber the entire drawing
at any time. To do this, select the Renumber Components... command from the
Components menu, or click the corresponding toolbar button.

Value
The value is either the numerical value of a component (e.g. "1k") or a type designation (e.g.
"BC547" or "SN7400"). With the option request value you have the option of entering the
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value directly when dragging the component onto the drawing.

visible
With this option you can show or hide the value of the part. This option can be useful for
some components that are of no value or that are perhaps not actually components at
all.

request value
If you activate this option, every time you drag this component from the library onto the
drawing, a small dialog appears in which you can enter the corresponding value. With this
option you can force yourself to enter the value of all resistors immediately, for example.
If you do not do this, you have to add all the values at the latest when you have finished
the drawing. A value can then be quickly forgotten.

Add to components list
If you deselect this field, the component will not be taken into account when generating a
components list. This is useful, for example, if the component is not actually a component at
all.

Additional texts 1..4 for components list
These additional texts only appear in the components list. Here you can enter special
information such as design, materials or order number.

Description for library
If necessary, you can enter a text here, which will then be displayed in the library directly
under the component. Please note that this text should not be too long.

Component editor
Use the Component editor button to open the component editor for the relevant component.
You can edit the appearance of the component as you wish within the component editor.

Component-Contacts
A component can have any number of contacts or, better yet, contact descriptions. These
are special names within a component. The advantage over fixed texts is that you can
change these texts quickly and easily in the component dialog. So you don't need to go
through the component editor first.

If contacts are defined in the component, a list of these contacts is displayed in the
properties, and you can then view and edit the contact names here:



57 / 104

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

The Component-Editor
 
To graphically change or expand a component, simply open the Component-Editor.
Either click on the Component-Editor button in the component properties, or simply
double-click on the component in your plan.

To change a component directly in the component library, first double-click on the
component in the library. the component is then highlighted in color and the component
properties are displayed on the right edge of the window. Here you can call the editor with
the component editor button. 

If the Component-Editor is called up, the component is displayed directly on the work
surface. In addition, the background color changes to light blue and a bar appears above the
work area: 

You can now freely edit the component here. All normal drawing functions are available to
you.

The two fixed text elements [ID] and [Value] are shown here in square brackets. You can
freely determine the position of these texts in relation to the component. You can also
change the text properties (font, color, size) of these text elements. The only thing you
cannot change here is the text itself. This is just a placeholder, so to speak, for the final
texts in the drawing. These two items cannot be deleted either. If you do not want these to
appear on your component, you can switch off the visibility of these text elements in the 
component properties.

If you want to exit the component editor again, click either on Save and Exit or on Cancel.
You will then automatically find yourself back on your drawing.

Contacts
Another special feature of the component editor is the ability to define contacts.
Contacts are actually nothing more than normal texts. However, contacts do not have a
fixed text in the component, but you can edit the texts quickly and easily in the component
properties.

Contacts are usually used to label or number the connections of a component. Of course,
normal text can also be used for this. But if the connection names are not always the same,
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it makes sense to define them with contacts instead of normal texts. You only need to add
the component to the library once. You can then change the texts of the connection
designations directly in the properties of the component without having to open the
component editor here.

You have to pay attention to one particularly important point when creating a component:
the insertion point of the component.

The insertion point / Red dot
The insertion point is shown as a red dot in the component editor. With this point you
determine how the component is inserted into your drawing. A snap grid is always stored on
the drawing, and this insertion point of the component is always on a grid point. Only with
the correct determination of the insertion point is it possible to connect the various
components on the drawing directly with one another.
Normally you always set the insertion point of a component directly on a connector. Please
make sure that the insertion point is really EXACTLY on the connection. The easiest way to
achieve this is when the connection and insertion point lie on one grid point. Then the
accuracy is 100% guaranteed.

The grid setting in which you edit the component has no influence on how the component will
later behave on the drawing. You can therefore set the grid at any time during editing as
required, just as you need it.
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Contacts

A special feature of the component editor is the ability to define contacts. Contacts are
actually nothing more than normal texts. However, contacts do not have a fixed text in the
component, but the texts can be edited quickly and easily in the component properties.

Contacts are usually used to label or number the connections of a component. Normal text
can of course also be used for this. But if the connection names are not always the same, it
makes sense to define them with contacts instead of normal texts. You only need to add the
component to the library once. You can then change the texts of the connection
designations directly in the properties of the component without having to call up the
component editor. 

To insert a contact in the component editor, click on the corresponding button in the
toolbar.
This button only appears in the Component-Editor at the bottom as the last button.

Click on the button and a contact "sticks" to the mouse pointer and you can position this
contact as you like.

Edit properties of contacts
Whenever you select a contact, you can set its properties in the properties panel on the
right-hand side of the window. You can also select several contacts at the same time and
change their properties together. 
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Name
Enter a name for the contact here. You can use this name to identify the contact when
editing the contact list in the properties dialog of the component.

Text
Here you enter the text that is to be displayed in the component. This text can then be
edited later in the properties of the component within the contact list.
With the button "..." you can call up an extended text dialog. Here you can also insert
variables or text constants, among other things.

Font
Here you can change the size and appearance of the text.

Create a contact list
In sPlan you can create a contact list. This list then contains all contacts with their
designations and the associated components. To create this contact list, select the Create
contact list... entry from the Functions menu. 

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

Create own Components
 
There are several ways to create your own components. The first decision you should make
is the following: Should the component be created from scratch, or can it be better derived
from an existing component?

Create component from scratch
If you want to create the component from scratch, right-click on the library and then select
the New command.

http://www.helpndoc.com
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When you execute this command, a new component is added directly to the bottom of the
library. As a default, sPlan always creates a new component as a square with a side length
of 20mm as a placeholder. The properties of the new component are displayed on the right
edge of the window. You can now change this here or call up the Component-Editor.

Create a new component from an existing component
If you want to create a component from another similar component, right-click on the
component to be copied in the library and then select the Duplicate command. A copy of
the component appears immediately at the bottom as the last component on the library
page. The properties of the new component are displayed on the right edge of the window.
You can now change this here or call up the Component-Editor.

Create component from selection
There is a third way to create a new component. To do this, simply select the elements you
want the new component to consist of on the drawing. Then choose the Create
component from selection command from the Components menu. A component is
immediately created from the selected elements.

Created with the Standard Edition of HelpNDoc: Full featured Help generator

Split Components
 
You have the option of splitting individual components into their constituent parts. All
properties of the component are lost in the process. After splitting a component, it is only
available graphically on the drawing.

To split a component, first select the desired component. Now select the Split selected
component command from the Components menu. You can also select and split several
components at the same time. 

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Change Component inscription
 
If you want to change the font, the color or the height of several or all component labels,
you can do this easily with the following dialog. To do this, call the Inscription... command
from the Components menu.
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In this dialog you can redefine the text height and font for the components for the identifier,
the value and the contacts. In the Apply to field, specify whether you want to apply the
changes for the entire project (i.e. for all pages of your project), for the current page, only
for selected components or for the current library page. The changes are carried out
immediately after confirming the dialog. 

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

Automatic Component Numbering
 
With this function, you no longer have to worry about the annoying numbering of the
individual components. You can leave this process completely up to the software, so you can
always be sure that all components are numbered correctly.

You can determine for each component individually whether it is eligible for automatic
numbering or not. In the properties of a component you can activate the "automatic
numbering" field to activate the function for this component. As an identifier, please enter
e.g. only the "R" for resistors (without a consecutive number!).
The software then considers all components on the drawing that also have the identifier
"R" (and have also activated the option "automatic numbering") as belonging together and
automatically attaches the consecutive numbers to the identifier.

Preferably make the changes to the components in the library and not to the individual
components on your schematic. If you have changed the component accordingly in the
library, all newly imported copies on the schematic will have the same properties as the
original in the library.

When you delete components on the drawing, there are gaps in the automatic component
numbering. To close this again, you can have the software renumber the entire drawing at
any time. To do this, select the Renumber components... command from the Components
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menu, or click the corresponding toolbar button. The following window then appears:

 
Here you select the pages over which the automatic renumbering should extend. After you
have confirmed this information, the following dialog appears: 

 
Here you can have a certain influence on the component numbering.

Geometric sorting

None
If you choose this option, the components are simply numbered consecutively in the order in
which they were created.

Columns
If you choose this option, the components are numbered column by column. This means that
e.g. components lying one below the other are numbered in ascending order.

Rows
If you choose this option, the components are numbered line by line. This means that e.g.
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components lying next to each other are numbered in ascending order.

Geometrical grid
If you have selected a geometric sorting (columns or rows), you can use this to determine
the "sample size". In the case of a geometric sorting, the drawing is scanned either column
by column or line by line with an imaginary square of a certain side length. All components
that then lie within this square are numbered first, then the square is shifted downwards
(column by column) or to the right (row by row) and the process begins again.
You can determine the size of this square in the "Geometric grid" field. Depending on the size
of the geometric grid, different numbering variants can arise.

Options

Only selected components
If you have selected components before calling up the dialog, you can determine here
whether only these components should be renumbered.

Only components with identifier:
If you enter an identifier (e.g. "R") here, only components with this identifier will be
renumbered.

Start at:
If the components are not to be numbered consecutively from 1, you can also specify a
different starting value here if necessary.
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Parent-Child Relations
 
Individual components can have a parent-child relationship to one another. A component
can be declared as a parent and other components can then declare this parent
component as their own parent and thus automatically become a child of the
superordinate parent.

A parent knows all of their children, and a child always knows their parent. This relation
enables the components to access the data of the associated component. For example, the
identifier of a child can automatically contain the name of its parent. If the identifier of the
parent then changes, the name of the child also changes automatically. Something like this
is particularly advantageous when using contactors and contacts or also with ICs with
several gates.

Here is an example with a contactor and 3 associated contacts: 

The contactor is a parent and has the identifier K1.
The contacts have assigned contactor K1 as a parent and are therefore automatically its
children. In this example, the children take the identifier K1 from the parent and
subsequently receive a sequential number.
If the identifier of the contactor changes, the identifiers of all contacts also change

http://www.helpndoc.com/feature-tour/iphone-website-generation
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automatically.
The contacts can also be distributed over several different pages of the project.

Here is another example of a 7400 IC: 

The main component on the left is the parent, and the 4 individual gates are the children.
In this example, the children take on the identifier IC1 and also the value 7400 of the
parent.
If the identifier or the value of the parent changes, all the identifiers and values of the
individual gates change automatically. Here, too, the gates can be spread over several
different pages of the project. 

 

Create a Parent-Child relation
The creation of a parent-child relationship is simple: You simply select another component as
the parent for any component. As soon as a component has a parent, it is automatically a
child of this parent. 

Define a Component as a Parent:
Only those components can be assigned as parents that have already been declared as
parents.
To define a component as a parent, select it and then click the Set PARENT status button
in the component properties. 

 

The component then has the parent status. 

 

Define a Child / Assign a Parent:
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If a parent is assigned to a component, it automatically becomes a child.
To assign a component to a parent, select it and then click the Assign PARENT... button in
the component properties.
Now select the desired parent from the list of available parents. 

You can also select several components at the same time and set the parent for all selected
components together. So if you have a contactor and 3 contacts as in the example above,
then select the 3 contacts and then assign all 3 components with the contactor as a 
parent.

After assigning a parent, the component is automatically a child. 

Automatic jumping to a Child or Parent:
If you select a parent with subordinate children, all children are listed in the component
properties: 
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You can now simply double-click on an entry within this list and you will be navigated to the
corresponding child, even if this should be on a different page.

The whole thing works the same way with a child. The linked parent is always displayed
here: 

With a double-click on the entry you will be navigated directly to the parent, even if this
should be on a different page. 

Parent-Child-Variables
So that a child can automatically adopt the identifier and the value of its parent, special
variables are used that are only available for the parent-child relationship:

<PARENT_ID>
Identifier of the parent
 
<PARENT_VALUE>
Value of the parent
 
<PARENT_PAGENO>
Page number of the parent

<CHILDNO>
Number of the child
 
<CHILDCHAR>
Alphabetical letter corresponding to the number of the child (a, b, c ...)
 
<CHILD_PAGENO>
Page number of the child

So that a child automatically adopts the identifier and the value of its parent, the
corresponding fields of the child are pre-assigned with 2 variables when they are linked to a
parent:

The identifier automatically receives the variable <PARENT_ID>
The value is automatically given the variable <PARENT_VALUE> 
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You can also change or extend this default as you wish.

<CHILDNO> and <CHILDCHAR>:

The parent manages its children and gives them a sequential number. The variable 
<CHILDNO> indicates this number. For example, if a parent has 3 children, then these 3
children have the numbers 1, 2 and 3. This number can e.g. be displayed in addition to the
identifier. To do this, define the identifier of the child as follows: <PARENT_ID> -
<CHILDNO>
Now the identifiers of the children on the plan will look like this: IC-1, IC-2, IC-3, ...

The <CHILDCHAR> variable specifies the serial number as a character, i.e. a, b, c ...
To do this, define the identifier of the child as follows: <PARENT_ID> - <CHILDCHAR>
Now the identifiers of the children on the map will look like this: IC-a, IC-b, IC-c, ... 

Child-List (Contact overview)
If you select a parent with subordinate children, all children are listed in the component
properties.
Here you can also create a child-list (contact overview) for the component: 

After clicking on Create Childlist (Contact overview), this dialog appears:
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Here you can make certain settings for the contact overview.
With a click on Paste... you can then place the contact overview on your plan: 

Colorize Parent-Child
sPlan can color-mark all parent-child components on the plan. This enables you to see at a
glance which components are defined as parents or children, and which children belong to
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which parent. 
 

 To switch this function on/off, please use this button in the upper toolbar of sPlan.

All parents are now highlighted in blue, all children in a light reddish background.
If you now select a parent or a child, the parent and all associated children are colored more
strongly and you can immediately see how the components belong together: 

 

Parent-Child in the Library
If it makes sense, you can include a complete parent-child structure as 1 component in the
library.
That would make sense e.g. for the above example of a 7400-IC with its 4 gates.
To do this, simply select the parent component and all of its children. Now click with the
right mouse button on the parent and select the entry Copy selected component (with
children) to the library. Only the parent component is added to the library, but the children
are stored in the parent. You can recognize this by the fact that a small triangle is displayed
in the library for this component at the bottom right. If you move the mouse to this triangle,
the associated children are displayed to the right of the component: 
 

 

 
If you drag such a component onto your plan, the parent component and its children will
be created. 
 

 

Create Parent-Child-List
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You can create a hierarchical list with all parents and their children.
This is useful, for example, for an extensive project with contactors and contacts, spread
across different pages. The associated children for all parents are displayed in this list. This
gives you a complete overview of all the pages in the project.
To create this list, select the entry Create Parent-Child-List... from the Functions menu. 

Created with the Standard Edition of HelpNDoc: Full featured Help generator

Component List
 
An important function of sPlan is the creation of component lists. If required, these are
created fully automatically by the software. You can then edit, print, load or save the
component list by hand as you wish.

To create a component list, select the Create component list... command from the
Components menu or click on the corresponding button in the toolbar. The following window
then appears: 
 

 
Here you select the pages over which the component list should extend. After you have
confirmed this information, the component list appears: 
 

http://www.helpndoc.com/feature-tour
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You can edit the component list as you wish within the component list window. You also
have the following options here:

Font
Here you can set the font and the font size of the component list.

Options

File data
With this option, various additional information is included in the component list:

·  Date and Time
·  Name and folder of the project file
·  Names of the individual pages for the component list

This data is inserted at the top of the component list.

Please note that if you change this option, the component list will be completely recreated.



72 / 104

Any changes that you have made by hand will be lost.

Summarize equal components
If you activate this option, all components with the same value are automatically combined
into one entry in the component list.

What looked like this before, for example ...

R1 = 1k
R2 = 1k
R3 = 1k

... then becomes:

R1, R2, R3 = 3 x 1k

This increases the clarity of the component list considerably.

Please note that if you change this option, the component list will be completely recreated.
Any changes that you have made by hand will be lost.

Additional text 1..4
Here you can show or hide extra columns for the additional texts (Z1..Z4)

Vertical lines
This allows you to add vertical dividing lines to the component list

Horizontal lines
This allows you to add horizontal dividing lines to the component list

Sort groups

Quantity
If you select this option, the component group that is most frequently represented will
appear first in the component list. All other groups then also appear in the order of their
frequency.

Alphabetical
If you select this option, the component groups are sorted alphabetically based on their
identifiers.

Print

Top margin / Left margin
Before printing, determine the top and left print margins so that the component list is not
printed right at the edge.

Portrait / Landscape
Determine the paper size before printing.

Print
Prints the component list
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Paste to page...

With the button Paste to page... you can insert the component list directly on the current
page: 

  

Export...
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With the button Export... you can export the component list as a text file: 

Clipboard
This function copies the component list to the Windows clipboard. From here it can be
inserted by any other program (e.g. Word). You can then continue to edit the component list
with the other program as you wish.

Save...
With this button you can save the current component list. The component list is saved in the
universal "rich text format" and has the ending ".RTF". Most word processing programs can
read this format.

Open...
With this button you can reopen an already saved component list. 

Created with the Standard Edition of HelpNDoc: Free Web Help generator

http://www.helpndoc.com
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The Component Library

The component library is located on the left edge of the sPlan window: 

The components are simply dragged from the library onto the drawing (drag & drop). To do
this, click with the mouse on the desired component in the library. With the mouse button
still held down, drag the component to the desired position on the drawing. There you
release the mouse button again.

The current library page is always displayed above the library. Simply click on this field and a
menu with all available library pages will open. Here you can simply select a new library page.
Since the library has a directory structure, you can also branch into subdirectories here. The
top entry "<---" always takes you back one level.

With this button you can display the library completely as a tree structure. 

You can rearrange the library as you wish:

· Copy components
· Sort components
· Delete components
· Create new components
· Copy library pages
· Delete library pages
· Rename library pages
· Create new library pages

The library has its own local menu (context menu). You can do this by moving the mouse
over the library and clicking the right mouse button once. Here you can quickly and easily
access all library management commands.

Created with the Standard Edition of HelpNDoc: Free Web Help generator

The Component Library

The component library is located on the left edge of the sPlan window: 

http://www.helpndoc.com
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The components are simply dragged from the library onto the drawing (drag & drop). To do
this, click with the mouse on the desired component in the library. With the mouse button
still held down, drag the component to the desired position on the drawing. There you
release the mouse button again.

The current library page is always displayed above the library. Simply click on this field and a
menu with all available library pages will open. Here you can simply select a new library page.
Since the library has a directory structure, you can also branch into subdirectories here. The
top entry "<---" always takes you back one level.

With this button you can display the library completely as a tree structure. 

You can rearrange the library as you wish:

· Copy components
· Sort components
· Delete components
· Create new components
· Copy library pages
· Delete library pages
· Rename library pages
· Create new library pages

The library has its own local menu (context menu). You can do this by moving the mouse
over the library and clicking the right mouse button once. Here you can quickly and easily
access all library management commands.

Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

Representation of the Library
 
You can influence how the library is displayed on the left-hand side of the screen. You can
determine how many columns the library should have and whether the signatures of the
components should be shown or hidden. You set these options directly below the library: 
 

http://www.helpndoc.com/feature-tour
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The two buttons "+" and "-" increase or decrease the number of columns in the library.

With the button next to it you can show or hide the component signatures.

Use the two arrows up and down to select the previous or next library page.

The magnifying glass icon lets you browse the library 

You can determine the width of the component library directly with the mouse. To do this,
move the mouse to the right border of the library. The mouse pointer will now turn into a
double arrow. You can now determine the width of the library by holding down the mouse
button. 

Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator

Edit a Library page
 
You can design the component library according to your wishes. You receive all the
necessary commands when you right-click on a component in the library:

Properties
This calls up the component properties of the currently selected component.
Alternatively, you can simply double-click the desired component.

Properties (all)
This calls up the component properties for all components on the current library page.
Changes you make here are applied to all components on the current library page. So be
careful here.

New
When you execute this command, a new component is added directly to the bottom of the
library. As a default, sPlan always creates a new component as a square with a side length
of 20mm as a placeholder. The properties of the new component are displayed on the right
edge of the window. You can now change this here or call up the component editor.

Duplicate
If you want to create a component from another similar component, right-click on the
component to be copied in the library and then select the Duplicate command. A copy of
the component appears immediately at the bottom as the last component on the library
page. The properties of the new component are displayed on the right edge of the window.
You can now change this here or call up the component editor.

Delete...
This will delete the selected component from the library page.

 
Library page ->

New...
This creates a new blank library page.
After executing this command, enter the desired name for the new page. e.g. "resistors".
When assigning names, make sure that the library pages are sorted alphabetically. You
can also use the name to determine the position of the page in the list.

Copy...
With this you copy a complete library page.
Here, too, a new library page is created just like with the "Library page -> New"

http://www.helpndoc.com/help-authoring-tool
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command. The new page is not empty, however, but contains a copy of all components
of the currently selected library page.

Rename...
With this you can rename the current library page.
When assigning names, make sure that the individual pages are then sorted
alphabetically. You can also use the name to determine the position of the page in the
list.

Delete...
This will delete the current library page.
After confirming the security question, the page is then irrevocably removed from the
library.

Empty...
This will delete all components from the current library page.
After confirming the security question, the page is not deleted as with "Library page ->
delete ...", but it is still available, but empty.

Copy to page ->

This library page only
A new page is created and all components of the current library page are
automatically placed on this new page.

All library pages of this level
A new page is created for each library page and all components of the respective
library page are automatically placed on this new page.

Extras ->

Create backup ...
This will create a backup of your library as a ZIP file.

Restore backup...
You can use this to restore a previously created backup.

Reload library
With this you force a new reading of the library. This is particularly necessary if you have
made changes at the file level in the library directory. This saves you from having to
restart sPlan.

Explorer...
This calls up Windows Explorer with the current library directory.
This function is only intended for experienced users to work directly with the library files
(* .LIB). Here these files can be copied, removed, renamed or re-sorted at file level. 

Sort components within a page
To change the position of a component, simply drag it to the desired position. Simply click on
the component, hold down the mouse button, drag it to the desired position within the library
and then release the mouse button again. The position at which the dragged component is
inserted is shown with a red square while dragging.

Reorder or group library pages
The library in sPlan has a directory structure. Library files can be sorted and grouped in
subdirectories. However, this functionality is only directly accessible on the Windows file
level. With the function Extras -> Explorer (as described above) you can open a Windows
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directory window with the current library directory. Here you will find all LIB files sorted in the
respective subdirectories. Experienced users can create their own subdirectories here on file
level, copy LIB files, etc. in order to adapt the directory structure of the library to your
requirements.

Copy components from one library page to another
To copy a component from one library page to another, proceed as follows:

· First select the library page that contains the relevant component.
· Drag this component onto your schematic.
· Now select the library page into which the component is to be copied.
· Now click with the right mouse button on the component on the drawing and select the

command Copy selected component (s) to the library.

Tip:
With the last command you can not only copy 1 component, but any number of
components from the drawing to the library in one fell swoop.

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites
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Variables / Text Constants

In sPlan you can also use variables and text constants within text elements instead of
fixed texts.

Text constants
Text constants are simply stored texts that are available on demand at any time. If your
drawings often contain the same or similar texts, it makes sense to save these as text
constants. Every time you have to re-enter this text, you can then access these text
constants and save yourself typing.

Variables
Variables are an expanded form of text constants. They consist of a variable name and its
content, the variable text. The variable name is a placeholder for the actual variable text.

There are 2 different types of variables in sPlan. There are predefined fixed variables and
there are freely definable user variables. The predefined fixed variables are available
anytime and anywhere. The user variables can be defined by the user within a project and
are only ever valid within this project.

Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator

Fixed Variables

Variables can be used as placeholders within a text.
There are a large number of predefined so-called fixed variables in sPlan. You can use
these variables as you wish within a text and thus automate the texts in a way. The variable
name must always be embedded in the texts with the characters "<" and ">". A variable
looks like this, for example: <PAGENO>

Here is a simple example: 

   

You can reach the Extended text edit dialog simply by double-clicking on the text. 

Here the 2 variables <PAGENO> and <PAGECOUNT> have been used in the text. These
two variables supply the page number of the current page and the total number of pages in
the project. The variables change their content automatically. So if a new page is added to
the project, the text automatically changes to "This is page 1 of 3". 

http://www.helpndoc.com/help-authoring-tool
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Here is a list of all predefined fixed variables:

<PAGENO>
The page number 

<PAGECOUNT>
The total number of pages

<PAGENAME>
The name of the page

<FILENAME>
The name of the file (if saved)

<FILENAME_PURE>
The name of the file (if saved) without file extension

<FILEPATH>
The folder in which the file is saved

<FILEDATE>
The date of the file (if saved)

<FILETIME>
The time of the file (if saved)

<VERSION>
The program version (= "sPlan 8.0")

<TIME>
The current time

<DATE>
The current date

Variables that are only available within a component:

<BEZ>
A copy of the part identifier

<VALUE>
A copy of the component value

<Z1>
A copy of the additional text 1

<Z2>
A copy of the additional text 2

<Z3>
A copy of the additional text 3

<Z4>
A copy of the additional text 4
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If you have defined a form in the page properties, the following additional variables
are available:

<COLNUM>
The number of the COLUMN in which the component is located

<COLCHAR>
Alphabetical letter for the number of the COLUMN in which the component is located (A, B, C
...)

<ROWNUM>
The number of the ROW in which the component is located

<ROWCHAR>
Alphabetical letter for the number of the ROW in which the component is located (A, B, C ...)

Variables that are only available in connection with the Parent-Child
relationship:

Variables for use in Child components:

<PARENT_ID>
Identifier of the parent

<PARENT_VALUE>
Parent's value

<PARENT_PAGENO>
Page number of the parent

<PARENT_Z1>
Additional text 1 of the parent

<PARENT_Z2>
Additional text 2 of the parent

<PARENT_Z3>
Additional text 3 of the parent

<PARENT_Z4>
Additional text 4 of the parent

<PARENT_CONTACT_1>
Contact 1 of the parent (...2, ...3, etc.)

<PARENT_COLNUM>
The number of the COLUMN in which the parent is located

<PARENT_COLCHAR>
Alphabetical letter for the number of the COLUMN in which the parent is located

<PARENT_ROWNUM>
The number of the ROW in which the parent is located

<PARENT_ROWCHAR>
Alphabetical letter for the number of the ROW in which the parent is located
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<CHILDNO>
Child number

<CHILDCHAR>
Alphabetical letter corresponding to the number of the child (a, b, c ...)

Variables for use in Parent components:

<CHILD_PAGENO>
Page number(s) of the child

<CHILD_PAGENAME>
Page number of the (first) child

<CHILD_COLNUM>
The number of the COLUMN in which the (first) child is located

<CHILD_COLCHAR>
Alphabetical letter for the number of the COLUMN in which the (first) child is located

<CHILD_ROWNUM>
The number of the ROW in which the (first) child is located

<CHILD_ROWCHAR>
Alphabetical letter for the number of the ROW in which the (first) child is located

These <CHILD_...> variables always return the data of the first child.
If you have linked several child-components with the parent, you can also specify the
desired child number directly in the variables. Simply add an underscore followed by the child-
number to the end of the variable BEFORE the ">". For example, the variable
<CHILD_PAGENO_2> returns the page-number of the 2nd child, or <CHILD_COLNUM_4>
returns the column-number of the 4th child.

Variables that are only available within text links:

<LINK_PAGENO>
The page number on which the target text is located

<LINK_PAGENAME>
The name of the page on which the target text is located

<LINK_TEXT>
The text of the target text

<LINK_COLNUM>
The number of the COLUMN in which the target text is located

<LINK_COLCHAR>
Alphabetical letter for the number of the COLUMN in which the target text is located

<LINK_ROWNUM>
The number of the ROW in which the target text is located

<LINK_ROWCHAR>
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Alphabetical letter for the number of the ROW in which the target text is located

<LINKFROM_PAGENO>
The page number on which the source text is located

<LINKFROM_PAGENAME>
The name of the page on which the source text is located

<LINKFROM_TEXT>
The text of the source text

<LINKFROM_COLNUM>
The number of the COLUMN in which the (first) source text is located

<LINKFROM_COLCHAR>
Alphabetical letter for the number of the COLUMN in which the (first) source text is located

<LINKFROM_ROWNUM>
The number of the ROW in which the (first) source text is located

<LINKFROM_ROWCHAR>
Alphabetical letter for the number of the ROW in which the (first) source text is located

Created with the Standard Edition of HelpNDoc: Easily create Help documents

User Variables

User variables can be used as placeholders in a text. They consist of a variable name and its
content, the variable text. The variable name is a placeholder for the actual variable text.

The content of the variable then appears on the drawing instead of the variable name.

Here is a small example:

For example, if you define a variable called <PROJECTNAME> and have assigned the text
"Measuring amplifier project 45X2-9" to this variable, the text "Measuring amplifier
project 45X2-9" is displayed on the drawing for a text element with the content
<PROJEKTNAME> .

You could of course also write the text directly without a variable. The advantage of a
variable, however, is that if you use this variable several times in your project (possibly even
on each page), then you only need to change the content of this variable, and the text will
also change everywhere on the schematic where this variable was used. 

http://www.helpndoc.com/feature-tour
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You can reach the Extended text edit dialog simply by double-clicking on the text. 

Note that all user variables are always project-related. They are defined and saved within a
project (i.e. a file). They are therefore only ever valid within this file.

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites
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Text Constants

Text constants are simply stored texts that are available on demand at any time. If your
drawings often contain the same or similar texts, it makes sense to save these as text
constants. Every time you have to re-enter this text, you can then access these text
constants and save yourself typing. 

You can reach the Extended text edit dialog simply by double-clicking on the text. 
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Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator
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Miscellaneous Functions

Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Active Text-Links

In sPlan you can convert normal texts into active links.
There are 2 types of links: external and internal links:

External links:
You can use this to create a link to a website (e.g. "www.abacom-online.de") or refer
directly to a specific file (e.g. a PDF file with a data page).

Internal links:
With sPlan you can create active links from one point in the drawing to another point. It does
not matter whether the link is on the same page or a completely different page within your
project. You can automatically follow the links with simple clicks of the mouse. You can
therefore define jumps to completely different parts of your project and thus create
interactive drawings.

The link is created in the properties of a text: 
 

 
 

Internal Link:
With sPlan you can create active links from one point in the drawing to another point. It does
not matter whether the link is on the same page or a completely different page within your
project. You can automatically follow the links with simple clicks of the mouse. Here you can
define jumps to completely different parts of your project and thus create interactive
drawings.

A click on the "Select target ..." button shows a list of all possible jump targets for your

http://www.helpndoc.com
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project. Select the desired jump destination from this list. If you have not yet approved any
other text as a jump target, this list is initially empty.

With Delete target you can remove a defined jump target.

With Select new target... you can select a new jump destination, even if another jump
destination has already been defined.

With the "Publish as target" option, you determine whether the text should be available as
a jump target for other links.
If you want to remove the target option from a text, click again on the "No longer publish
as target" button.

Text elements with active links are automatically marked:

 
All possible jump targets receive an arrow pointing inwards on the left side.
All links with a target are given an arrow pointing outwards on the right-hand side.
This identification makes it possible to immediately identify which text elements are linked.

Follow a link
If you point to an active link with the mouse, the target of this link is displayed.
You can then execute the link with a double click. 

If you move the mouse over the right outer arrow, a small window will appear with the link
target.
With a double click on the right outer arrow you get to the linked text. 

If you move the mouse over the left inner arrow, a small window will appear with the text
linked to this text.
With a double click on the left inner arrow you get to the link that linked to this text
(source).

Create a Link-List
In sPlan you can create a link-list. This list contains all the links together with their names
and pages. To create the link-list, select the Create link list... entry from the Functions
menu. 
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External Link:
Here you can enter an external link to a website (e.g. "www.abacom-online.de") or refer
directly to a specific file (e.g. a PDF file with a data page).

Your text will then appear underlined on the plan, e.g. like this:
 

 
If you double-click on the underscore with the mouse, you execute this external link after a
security query and you will either be taken to the specified website or the corresponding file
will be opened.

Note that the text that appears on the map is not necessarily the same as the text on the
external link.
Usually, however, it makes sense to compare the displayed text with the link. 

Created with the Standard Edition of HelpNDoc: Free help authoring environment

Convert Line <> Polygon

In sPlan you can convert a line into a polygon or convert a polygon into a line.
A rectangle, a circle or a bezier curve can also be converted into a polygon or a line.
That sounds a bit banal at first, but it can be quite helpful in some situations and offers
interesting opportunities.

To do this, simply click on the desired element with the right mouse button and select the
Convert to Polyline or Convert to Polygon command.

Here are some application examples:

· Circle was drawn

· Circle was converted to line
(click with the right mouse button on the circle and select the command Convert to
Polyline)

· Some nodes were moved

· The line was cut in some places
(click with the right mouse button on the node and select the command Split line)

http://www.helpndoc.com/help-authoring-tool
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· Some nodes have been removed
(right-click on the node and select the command Delete node)

· Freehand line was drawn

· Freehand line converted to a polygon
(right-click on the freehand line and select the Convert to Polygon command)

· A fill was assigned to the polygon

· A geometric figure was drawn from a line and a semicircle

· The two elements were moved together

· The semicircle was converted to a line
(click with the right mouse button on the semicircle and select the command Convert
to Polyline)

· The two lines were joined so that they become one line
(click with the right mouse button on a node where both lines touch and select the
command Join lines)

· The line was converted to a polygon
(click with the right mouse button on the line and select the command Convert to
Polygon)

· A fill was assigned to the polygon 

Created with the Standard Edition of HelpNDoc: Free help authoring tool

http://www.helpndoc.com/help-authoring-tool
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Printing
 
Of course, you also have the option of putting your drawing on paper. The software has a
very intuitive and clear print preview. In the print preview you can determine the printer, set
the printer, freely select the scaling, position the printout freely on the paper, etc. All
settings that you make in the print preview are immediately visible in the preview, so that
you do not have any experience unpleasant surprises.

Use the "Print" command in the "File" menu or the corresponding toolbar button to access
the print preview. You can also enlarge this window as required to improve the accuracy of
the preview. 
 

 
At the top of the print preview you can select the printer you want and with Setup... you
can call up the setup dialog for the selected printer.

Below the print preview there is a scroll bar in which you can select the page to be printed
with one click.

Paper preview and the red frame
The paper is shown as a white page. The red frame indicates the printable area on the
paper. The size of this frame depends on your printer or its printer driver.

You can move the drawing freely on the paper. To do this, click with the mouse on the white
surface of the paper and, with the mouse button still held down, drag the drawing to the
desired position. The displacement of the drawing is displayed as an offset in the left bar.
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With a click on Reset, this offset can be set directly to 0 again, thus undoing the shift.

As soon as part of the drawing is outside the printable area, the corresponding frame side is
colored red: 

In addition, the Print button changes from green to red to show that the printout would be
cut off with the current settings.

In the lower page bar, all pages that are cut off are automatically marked with a [!].

Scale
Here you can decide whether you want the expression to be exactly "1:1" or whether you
prefer to scale the expression freely. If you have selected "User", you can freely set the
scaling with the slider. You can follow the scaling online in the print preview.

Offset
You can move the drawing freely on the paper. To do this, click with the mouse on the white
surface of the paper and, with the mouse button still held down, drag the drawing to the
desired position. The displacement of the drawing is displayed as an offset in the left bar.
With a click on Reset, this offset can be set directly to 0 again, thus undoing the shift.

Banner
Here you have the option of printing a drawing on several pages.
Enter how many pages you want to use in the X or Y direction. In the Overlap field. you can
provide an overlap of the individual pages in mm. You can now scale and move the printout
so that it fits on all pages.

Functions

Adjust (size and position)
Scales and centers the drawing so that it fits on the page as best as possible

Center
Centers the drawing on the page

All pages -> ...
Automatically applies the function to all existing pages

Apply to all pages -> ...
All other pages take on the corresponding value of the current page

All pages -> Reset print settings
Resets all print settings for all pages 

Orientation
With Automatically, the page orientation is always set as it was defined in sPlan (portrait or
landscape).
You can also force the page orientation into the appropriate format with portrait or
landscape format. 
 
Printing
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With the option Current page only the page currently displayed is printed out.
With the option All pages all pages of your project are printed out.
With the option Selection you can determine yourself which pages should be printed out. To
do this, enter the page numbers in the field separated by commas, or click on "..." to select
the individual pages via a selection dialog.

With the button Print you start the printout: 

The number in square brackets indicates the number of pages to be printed. 

If the button is red, this indicates that at least one page will bee cut off during the printout.
See the section Paper preview and the red frame above.

Close
This closes the print preview and returns you to your drawing. 

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Export
 
You can export your drawing in various file formats. This allows you to integrate your
drawings into other programs or publish them on the network. You can choose between 5
different file formats:

· JPG
· PNG
· BMP
· EMF
· SVG

JPG, PNG and BMP files are pixel format files. The conversion of a vector graphic (sPlan itself
works with vector graphics) into a pixel format is always lossy. With the setting of a high
resolution, however, you can minimize these losses here. However, this is then at the
expense of the file size.
As a rule, the JPG format is preferable to the BMP format, as it creates much smaller files
with the same resolution.

EMF files are vector format files. Since sPlan also works in vector format, a loss-free export
is theoretically possible. The EMF format is a Windows-specific vector format that can be
read by many other graphics programs. Unfortunately, there are often compatibility problems
here, so that the result is not always satisfactory. We recommend avoiding this format. It is
actually only available in sPlan for reasons of compatibility.

The SVG format is also a vector format. SVG stands for Scaleable Vector Graphics. SVG files
can now be used directly by many browsers (Firefox, etc.) and other programs, and should
definitely be preferred to the EMF format.

To export the drawing, select the "Export..." function from the "File" menu. The following
dialog then appears:

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Filetype
Here you enter the desired file type of the target file.
 
Resolution (only for JPG and BMP)
When exporting to a JPG or BMP file, it is necessary to specify the resolution of the pixel
graphic to be created.
Use the slider to set the desired resolution. Please note that the file size of the target file
increases with increasing resolution.
 
Color (only for BMP)
This information is only necessary for the BMP export. The other file formats are generally
colored.
If possible, please select the "S / W" option here. Only if you absolutely need a colored
drawing, please select the "Color" option. The reason for this is simple: a colored bitmap
requires approximately 24 times as much memory as a monochrome bitmap. The same bitmap
occupies, for example, 500 Kbytes of memory in b / w, as a colored bitmap, a full 12 Mbytes
of memory. Even if you have drawn the drawing in color, you can create a b / w bitmap if it
is enough for you. The individual colors are reproduced using a grid.
You can see the required memory value for the bitmap online in the window.

Transparent (only for PNG)
Creates a graphic with a transparent background

Selection
Here you specify what you want to export: 
 

Current page
The entire page is exported in full size with all elements.
 
All elements
Everything is also exported, the page size is determined by a comprehensive rectangle
over all elements.
 
Selected elements
Only the selected elements are exported.
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All pages
All pages of the project will be exported. Each page is exported to a separate file.
The files are each appended with the page number, so several files are automatically
created, such as:

o filename_1.jpg
o filename_2.jpg
o filename_3.jpg
o filename_4.jpg  

 

After you have made and confirmed the desired settings, a "Save As" dialog appears in which
you can specify the target folder and the file name. The file is then generated and saved. 

Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Bitmap-Explorer

All bitmaps used in your project are listed in the Bitmap-Explorer. In this way you can quickly
get an overview of all bitmaps, their resolution and their memory requirements.

You can open the Bitmap-Explorer at any time with the Bitmap-Explorer... command from
the Functions menu. If you have selected a bitmap, you can also open the Bitmap-Explorer
directly in the properties panel on the right-hand edge of the window: 

Here you can directly specify a maximum value for the resolution (DPI) of the bitmaps and
automatically adjust all bitmaps with a higher resolution to this maximum value. Depending on
the bitmaps used, this can save a lot of memory and thus make your sPlan project more
handy and faster. 

Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator

http://www.helpndoc.com
http://www.helpndoc.com/help-authoring-tool
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Paste Table of Contents

If desired, a table of contents can be inserted directly into your drawing as a kind of table.
The table of contents is like a list with all the pages in your project.

To create a table of contents, select the Paste Table of Contents... command from the
Functions menu. The following window then appears: 

Here you can select all pages that should be included in the table of contents.
The following dialog then appears: 

Here you can still make certain settings.
After clicking on Paste you can then place the table of contents on your drawing: 
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Created with the Standard Edition of HelpNDoc: Free help authoring environment

Scale
 
You can give each page in sPlan its own scale.
sPlan then automatically takes this scale into account for all coordinates, rulers, dimensions,
etc.

The properties of a page are displayed in the properties panel on the right edge of the
window if no other element is currently selected on the plan. You can also find the Scale
section here: 

 

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Search / Replace
 
sPlan offers a special search function to search for components or texts and, if necessary, to
replace them automatically. Particularly in the case of somewhat larger projects with a large
number of pages, it can be difficult to identify a specific component or text on the drawing.

To activate the component search, select the Search/Replace... command from the Edit
menu or click directly on the corresponding button (right-aligned in the toolbar): 

 
The search panel is then displayed on the right-hand side of the window.
You can hide the search panel again at any time with another click.

At the top you can choose whether you want to search for components or for texts: 

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com/feature-tour
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Search only

Enter your search text for the component search in the Identifier and/or Value fields, or for
the text search in the Search text field.

The search results are automatically sorted by pages and displayed in a tree structure.
If you click on a search result, the element is automatically displayed on the drawing. If the
element is on a different page, the page is also switched automatically. So you can easily
control and examine all search results. 

Search and Reaplace

First, proceed exactly as described for Search only above so that the search results are
displayed.

Replace a single element
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If you now select a result you can use the button Element -> to replace the text in the
corresponding element with the text specified in the Replace field. This only replaces the
text in the one selected element.

Replace all elements of a page
You can also replace all elements of a page at once. To do this, select the superordinate
page in the search result instead of a single element. The Element -> button now becomes
a Full page -> button. With this you can now replace all elements of this page at once.

Replace all elements on all pages
You can also replace all elements of all pages at once. To do this, select the top entry All
pages in the search result instead of an individual element or a page. The Element ->
button now becomes an All pages -> button. With this you can now replace all elements on
all pages (i.e. the complete result list) at once.

Search options

When searching, you still have a few options that influence the search result:

Only component list elements
This option is only available when searching for a component. If you activate this field, only
those components will be taken into account that have activated the "Add to component
list" field. This is likely the case for most components anyway.

Case sensitive
The search is case-sensitive or not.

Resolve <Variables>
If there are variables in the text, either the original text with the variable names ("This is
page <PAGENO>") or the text with the resolved variables ("This is page 1") is used for the
search. For example, if you want to search for variable names directly, you would have to
deactivate this option.

All Pages
If this option is activated, the search automatically extends over all pages in the project.
Otherwise, the search is only ever made on the current page.

The "Update" button
This allows you to restart the search at any time and update the results.
The list of results is automatically updated with every change in the search panel. However,
if a search has been made and elements are then deleted or changed on the plan, a manual
update may be necessary. 

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Keyboard Control

You can also use the keyboard to access many of the sPlan functions if required.

Functions that are often required such as copy, paste, duplicate, delete, etc. can be
accessed using special key combinations. These key combinations are displayed next to the
menu entry in the sPlan main menu.

Other functions can be controlled via the keyboard:

Drawing modes

http://www.helpndoc.com
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There is a hotkey for each drawing mode in the vertical toolbar. So you can simply select the
corresponding drawing mode with the keyboard instead of the mouse
The following hotkeys are preset as standard:

Edit = ESC
Line = L
Connection = P
Rectangle = R
Circle = C
Polygon = O
Bezier = U
Freehand line = H
Special forms = S
Dimensions = D
Text = T
TextRect = E
Bitmap = F
Zoom = Z
Measure = M

In the General Settings you can define the hotkeys yourself if necessary.

Move elements with the arrow keys
Selected objects on the drawing can also be moved with the arrow keys on the keyboard.
The elements are shifted by one grid point in the desired direction. If you also press the CTRL
key, you can switch the grid to fine (0.1 mm) and fine-tune it using the keyboard.

Select elements with the TAB key
With the TAB key you can select the individual elements of the drawing one after the other.
Each press of the TAB key selects the next element. If you also press the SHIFT key, the
previous element is selected instead of the next element.

Call the Component-Editor with Alt-Return
When a component is selected, you can call the Component-Editor with Alt-Return.

Zoom using the keyboard
F5 zooms in on the whole page
F6 zooms in on all elements of the drawing
F7 zooms in on all selected elements of the drawing
+ zooms in
- zooms out

Follow a text link with F8
With the function key F8 you can follow an active text-link. To do this, the text element with
the link must be selected. 

Created with the Standard Edition of HelpNDoc: Free Web Help generator

Translation into other languages

Most of the texts used in sPlan are saved in a file called "Translations.txt".
This file is located in the folder "C:\ProgramData\sPlan80\".
The name of this folder may vary depending on the version of Windows.

http://www.helpndoc.com
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This file contains all texts in the following format:

1100;Bearbeiten;Edit;Editer
1101;Rückgängig;Undo;Retour en arrière
1102;Wiederherstellen;Redo;Retour en avant
...

· Each line defines exactly one text

· Each line begins with an identification number that sPlan uses to identify the text

· This is followed by 3 texts,separated with ";" 

· The 1st text is used for the language selection GERMAN

· The 2nd text is used for the language selection ENGLISH

· The 3rd text is used for the language selection FRENCH

If you want to enter a new text, you can simply add the desired text as the 4th text:

1100;Bearbeiten;Edit;Editer;My own text

· Note that your own text must be separated with a ";"  from the last text

· As soon as a fourth text is available, sPlan will always use it, regardless of the selected language.

· In this way, you could completely translate the sPlan into a new language.

· Please note that the changes in this file only take effect after restarting sPlan.

You can also simply delete the "Translations.txt" file.
The next time sPlan is started, this file is automatically created again with the 3 standard languages 
(German, English, French).

Only the CHANGES you want are saved in this file.
So you can simply delete this file at any time in order to reactivate the default sPlan translation. 

Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

Software-Registration
 
This option has nothing to do with the actual function of the software. You can use it to
register your software directly with ABACOM, the manufacturer of this software. We will
then automatically notify you of updates and new versions.

You can register in the main menu under Help -> Software registration...
We recommend registering by email.

Note:
If you obtained the software directly from ABACOM, this separate registration is not
necessary. 

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator
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Tips and Tricks

· With <ESC> or with the right mouse button you can automatically return to the
standard mode from any mode.

· With the CTRL key you can deactivate the active grid snap (or the angle snap when
rotating) at any time. In this way you can also reach points outside the grid without
completely deactivating the grid snap.

· With the SHIFT key you can deactivate the set angle snap at any time when drawing a
line.

· If you click on a selected element again, the surrounding sizers change and you can
now rotate and shear the element with the mouse.

· When you have selected a line or a polygon, you can move individual line segments within
the line or the polygon by holding down the <ALT> key at the same time.

· You can also position the texts of a component such as identifier, value or contacts
directly on the drawing. Simply click on the text element (the component must not be
selected beforehand) and move it to the desired position. You do not need to call up the
component editor for this. This function can be deactivated in the General Settings if
necessary.

· With a double click on an empty space you can move the visible image section with
the mouse. Simply double-click on an empty space, hold the mouse down and move the
image section with the mouse.

· You can easily edit the arrangement of the components within the library using drag &
drop. Click on a component in the library and simply drag it to the new location within the
library.

· You can easily change the width of the component library with the mouse.
· If you want to add forms to your drawings, sPlan offers special functions for this.
· If you would like to present your drawings on the Internet, first export the drawings in a

high resolution, e.g. in JPG format. Alternatively, you can offer your plans as *.SPL files
for download and refer to the license-free viewer. 

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator
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The "sPlan-Viewer"

 
The sPlan-Viewer is a free and independent program with which sPlan files can be opened,
viewed and printed out. This gives every user access to sPlan files.

The sPlan-viewer is freeware. You are free to pass on the viewer and thus also give other
users the opportunity to view or print out your drawings without sPlan having to be installed
on the relevant computer.

The sPlan-Viewer is freely available here on our homepage: 

https://www.electronic-software-shop.com/lng/en/support/free-viewer-software/

Created with the Standard Edition of HelpNDoc: Easily create Help documents
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